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Chapter 1

Introduction

Use the Gentran Integration Suite 4.3 Windows Cluster Installation Guide to install Gentran Integration 
Suite 4.3 in a clustered (multiple node) Windows environment. 

This guide focuses on these installation tasks, including:

✦ Setting up the database
✦ Installing the Gentran Integration Suite software
✦ (If licensed) Installing and configuring MESA Developer Studio
✦ Configuring properties files
✦ Configuring installation utilities
✦ Configuring Gentran Integration Suite for a non-English environment
For upgrades, use the Gentran Integration Suite 4.3 Windows Cluster Upgrade Guide.



Chapter 2

Setting Up the Database (Windows)

Creating and Configuring the Database Server (Windows)
You must install, create, and configure a database so that each Gentran Integration Suite instance has a 
dedicated schema and login for the database.

Caution: If you are reinstalling Gentran Integration Suite, be aware that data in your existing database will 
be deleted. To prevent this, either back up the existing database or save it under a different name

Caution: After creating and configuring your database, recycle the database. Then stop and restart Gentran 
Integration Suite to apply the changes. 

In a Windows environment, Gentran Integration Suite supports the following databases:

✦ Oracle 9i or 10g
For more information, refer to Installing Oracle on page 9.

✦ Microsoft SQL Server 2000
For more information, refer to Installing Microsoft SQL Server 2000/2005 on page 15.

✦ Microsoft SQL Server 2005
For more information, refer to Installing Microsoft SQL Server 2000/2005 on page 15.

✦ DB2
For more information, refer to Installing DB2 on page 17.

✦ MySQL (non-clustered only)
For more information, refer to Using a MySQL Database Server (Non-Clustered Only) on page 19.

See System Requirements for supported version information.

Database Sizing
Database sizing is designed to give you estimates of the database growth and to assist in planning the disk 
requirements. 

Capacity Planning
Sterling Commerce, an IBM Company 8



Creating and Configuring the Database Server (Windows)
There are many factors to consider when estimating the amount of disk space that will be required for 
Gentran Integration Suite. As a result, trying to consider all growth factors is impractical because the user 
may not know the answers to many questions that are required to do a detailed forecast. Over the years the 
cost of disks has dramatically decreased, and the capacity and speed of disks has increased. The method of 
how information system managers order disk capacity has also changed from purchasing disk arrays that 
are dedicated to a particular database server and project to the concept of SANS. 

Gentran Integration Suite provides a methodology to estimate your initial disk requirements. Consider the 
confidence that you have in your data estimates when making the final purchase decision and adjust 
accordingly. After the initial purchase and production deployment, disk growth should be tracked for future 
purchase forecasts.

Tracking and Estimating Future Disk Requirements
You should regularly track your actual database storage usage and number of database records. Correlating 
these two metrics enabled you to plan your future disk requirements. Moreover, determining the average 
amount of space used for each order line or shipment line, enables you to accurately predict your future 
growth requirements.

Installing Oracle
You can use an Oracle database for maintaining information on Gentran Integration Suite. The following 
sections provide the necessary steps to install and configure an Oracle database for production:

✦ Choosing a Character Set on page 9
✦ Oracle Database User Privileges on page 10
✦ Configuring an Oracle Database for Production on page 11

Choosing a Character Set
To install Oracle with single or multiple byte characters, perform these steps:

1. If you do not have Oracle installed, perform the installation procedures in your Oracle Installation 
manuals.

2. Run the create instance procedure. Use a character set appropriate for your desired language, using the 
following command:
CHARACTER SET "AL32UTF8"
Sterling Commerce, an IBM Company 9



Creating and Configuring the Database Server (Windows)
3. Configure the INIT<INSTANCE_NAME>.ORA file for Oracle as follows: 
open_cursors= <set to appropriate value>

For example, the minimum value for WebLogic equals number of threads (across all application 
servers) + (connection pool size X prepared statement pool size). 
cursor_sharing=exact

compatible=<10.2.0.1>

timed_statistics=true

db_block_size=8192

optimizer_mode=CHOOSE

If you are using multi-byte character set, set the following and restart Oracle:
nls_length_semantics=CHAR

Alternatively you can run:
alter session set nls_length_semantics = CHAR

prior to running any create table scripts.
Setting this attribute ensures that the field sizes are not impacted by the number of bytes a data type 
can store. For example, Varchar(40) would now be able to store 40 Japanese characters instead of 40/3 
bytes in the AL32UTF-8 character set.
Note: When you change the multi-byte character set to CHAR by setting nls_length_semantics = 
CHAR, Oracle reserves space equivalent to 'n' chars, which is more than 'n' bytes. Therefore, when 
you run the dbverify.cmd command, the reduced entries in table columns are printed in the 
Yantra_TableDrops.sql file.

4. Download the Oracle JDBC driver ojdbc14.jar from the Oracle web site and copy to a well-known 
location for reference during installation.

Oracle Database User Privileges
Caution: The access given by these Oracle permissions might violate your internal security policies, since 

they give the Gentran Integration Suite user access to all schemas in the Oracle database.  You 
might need to refine your permissions to give the user access to just the necessary non-Gentran 
Integration Suite database objects.

Unless specifically stated for a given task, Gentran Integration Suite user does not require database 
administrator (DBA) privileges.

The following are some of the basic privileges that are given to Gentran Integration Suite administrative 
user who is involved in creating and modifying the Oracle database:

✦ ALTER SESSION
✦ CREATE PROCEDURE
✦ CREATE SEQUENCE
✦ CREATE SESSION
✦ CREATE SYNONYM
✦ CREATE TABLE
Sterling Commerce, an IBM Company 10



Creating and Configuring the Database Server (Windows)
✦ CREATE VIEW
✦ EXECUTE ANY PROCEDURE
✦ INSERT ANY TABLE
✦ UPDATE ANY TABLE
✦ SELECT ANY TABLE
The following are some of the basic privileges given to the application user whose involvement is restricted 
just to running the application:

✦ ALTER SESSION
✦ EXECUTE ANY PROCEDURE
✦ INSERT ANY TABLE
✦ UPDATE ANY TABLE
✦ SELECT ANY TABLE

Configuring an Oracle Database for Production
You need to configure your Oracle database for running in a production environment with Gentran 
Integration Suite. To configure an Oracle database for a production environment, you must:

✦ Size the database by estimating the required disk space. For more information, refer to Database 
Sizing on page 8.

✦ Create views and db_link or synonyms for integrating with the Sterling Warehouse Management 
System installation.

✦ Set the database connection properties.

To create the Oracle database to handle multiple byte characters, do the following:

1. Do not modify Gentran Integration Suite DDL.
2. Choose the correct data encoding format for your language. 
3. Choose the character set suitable for your language. 

To configure Oracle database for your production environment manually, you must set up and run a series 
of scripts to create the tables, indexes, sequences, and so forth for your schema. 

These script files reside in the \install_dir\install\database\oracle\scripts directory. The table, index, and 
sequence creation DDLs are created during installation. These reside in \install_dir\install\repository\scripts 
directory.

To set up scripts (if you are using locally managed tablespaces or another utility to size your database), do 
the following: 

1. Create tablespaces where the Gentran Integration Suite tables and indexes reside.
2. If you are manually creating database tables after installation (instead of having installation create 

them automatically), do the following: 
Modify the \install_dir\install\repository\scripts\EFrame_TableChanges.sql file to reference your 
newly created tablespaces. 
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The DDLs in the Gentran Integration Suite scripts create a standard set of indexes. You may need to create 
additional indexes or modify existing indexes according to your business practice.

To run the scripts, do the following:

1. Log into the Oracle server manager as sysdba.
2. Create the user that is the designated schema owner.
3. Grant the privileges listed in the Installation Checklist to the newly created user.
4. Log out of the Oracle Server Manager and log back in as the newly created user.
5. Verify the database.
6. Load Gentran Integration Suite database factory defaults.
7. Check for the degree of parallelism, using information from the Application Performance 

Management Guide.

Using an Oracle Database Server
You can use an Oracle 9i or 10g database with Gentran Integration Suite. See System Requirements for 
supported version information.

To use an Oracle 9i or 10g database, follow this process:

✦ Create the database. Refer to the Oracle documentation for information about creating the database, 
including creating a schema repository, login, and tablespace. Be sure to install the correct version and 
patches. 

✦ Configure the database by completing the following tasks: 
Setting Database Parameters in Oracle on page 12

Rolling Back or Undoing Changes in Oracle on page 13

Granting Permissions in Oracle on page 13

Installing the JDBC Driver in Oracle (Windows) on page 14

Enabling Failover in a Multiple Node Oracle RAC Database Cluster (Windows) on page 14

Setting Database Parameters in Oracle
Gentran Integration Suite requires the following parameter settings in your Oracle database:

Parameter Value

Number of open cursors Greater than or equal to 2000

cursor_sharing EXACT

Database block buffers Greater than or equal to 19200
Note: Sterling Commerce recommends that this be set to 0 if 

SGA memory equals greater than 0.
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Rolling Back or Undoing Changes in Oracle
You can roll back or undo changes in Oracle using one of the following methods:

✦ (Oracle versions earlier than 9i) Gentran Integration Suite recommends that you configure a rollback 
segment for every four concurrent users. Each rollback segment must be extendable to 25 MB. The 
values of the initial segment and the next segment can vary between 256 KB and 10 MB. Note that 
these ranges will vary based on the size of your Gentran Integration Suite database and the number of 
business rules it contains.

✦ (Oracle versions 9i or later) These versions support AUTO UNDO management. It is recommended 
that you use this option. This will avoid any manual monitoring of UNDO segments.
If a server is upgraded from Oracle 8i, set the UNDO_MANAGEMENT=AUTO parameter in 
init<SID>.ora. Your database administrator needs to figure out the UNDO_RETENTION setting. 
Make sure that the file system which has the UNDOTBS1 tablespace has enough space to 
AUTOGROW.

Granting Permissions in Oracle
Grant the following permissions to a Gentran Integration Suite user:

GRANT "CONNECT" TO <USER>
GRANT SELECT_CATALOG_ROLE TO <USER>
ALTER USER <USER>DEFAULT ROLE "CONNECT",

SELECT_CATALOG_ROLE
GRANT CREATE PROCEDURE TO <USER>
GRANT CREATE TRIGGER TO <USER>
GRANT CREATE TYPE TO <USER>
GRANT EXECUTE ANY PROCEDURE TO <USER>
GRANT EXECUTE ANY TYPE TO <USER>

System Global Area (SGA) 
memory (10g only)

Greater than 0
Note: Sterling Commerce recommends that the database 

block buffers be set to 0 if SGA memory equals greater 
than 0.

Shared pool size Greater than or equal to 90000000

Large pool size Greater than or equal to 614400

Java pool size Greater than or equal to 20971520

Number of processes Greater than or equal to 500

Log buffer Greater than or equal to 163840

Database block size Greater than or equal to 8192

Sort area size Greater than or equal to 65536

Sort area retained size Greater than or equal to 65536

Max extends Unlimited

Character set AL32UTF8

Parameter Value
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GRANT SELECT ANY TABLE TO <USER>
GRANT SELECT ANY DICTIONARY TO <USER>

For Oracle 10g 10.2.x, also grant the following permission:
GRANT "RESOURCE" TO <USER>;
ALTER USER <USER> DEFAULT ROLE "CONNECT","RESOURCE",SELECT_CATALOG_ROLE;

Note: If you are using Oracle AQ for Oracle 9i or Oracle 10g, then grant the 
AQ_ADMINISTRATOR_ROLE permission.

Installing the JDBC Driver in Oracle (Windows)
Gentran Integration Suite requires the appropriate JDBC driver for Oracle Database 10g and Oracle 9i 
databases. These drivers are thin client based pure Java JDBC drivers. See System Requirements for 
supported version information.

The supported versions of the JDBC driver will build the correct Gentran Integration Suite directory 
structure.

After obtaining the correct JDBC driver, record the absolute path to its location on your system. You must 
supply this absolute path when installing Gentran Integration Suite.

Enabling Failover in a Multiple Node Oracle RAC Database Cluster (Windows)
To enable failover in a multiple node Oracle RAC database cluster in Windows, do the following:

1. Navigate to the install_dir/install/properties directory to modify sandbox.cfg file.
2. In the sandbox.cfg file, add a new property for ORACLE_JDBC_URL, which contains the Oracle 

RAC connection URL.
The following example shows the suggested URL form and the way it is organized. However, the 
property value must be one string of text starting with ORACLE_JDBC_URL=. Your database 
administrator (DBA) can modify this URL as needed.
jdbc:oracle:thin:@

  (DESCRIPTION=

    (ADDRESS_LIST=

      (FAILOVER=ON)

      (LOAD_BALANCE=OFF)

      (ADDRESS=(PROTOCOL=TCP)(HOST=myhost1)(PORT=1521))

      (ADDRESS=(PROTOCOL=TCP)(HOST=myhost2)(PORT=1521))

     )

     (CONNECT_DATA = (SERVER = DEDICATED)(SERVICE_NAME = myservicename))

   )

3. Run the setupfiles.sh command from the install_dir/install/bin directory.
4. Set the propagation delay on the RAC server to 0.
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Installing Microsoft SQL Server 2000/2005
You can use a Microsoft SQL Server 2000/2005 database for maintaining information on Gentran 
Integration Suite. When using a Microsoft SQL Server database with Gentran Integration Suite, see System 
Requirements for supported version information. 

If you do not have SQL Server installed, follow the installation procedures in your SQL Server installation 
manual. Refer to the SQL Server documentation for information about creating the database, including 
creating a schema repository, login, and tablespace. Be sure to install the correct version and patch.

Note: Ensure that TCP/IP protocols are enabled in the network utility of the SQL Server.

Note: For SQL Server 2005, do not use case-sensitive column names in the database. Case-sensitive names 
will prevent the SQL Server 2005 System Management Console from loading.

Setting Database Parameters in SQL Server
To create a database, ensure that the collation property you select supports all the characters for your 
database.

Gentran Integration Suite requires the following parameter settings in your SQL Server database:

SQL Server Database User Privileges
In SQL Server, you must grant DBO (Database Owner) permission to Gentran Integration Suite user. The 
DB_DDLADMIN role is required for creating objects in the SQL Server database. 

Configuring a SQL Server Database for a Production Environment
You need to configure your SQL Server database for running in a production environment with Gentran 
Integration Suite. To configure a SQL Server database for a production environment, you must:

✦ Size the database by estimating the required disk space. For more information, refer to Database 
Sizing on page 8.

✦ Run the database scripts to create tables, indexes and so forth for the SQL Server database. 
✦ Set the database connection properties.
To run the scripts for the SQL Server database, do the following:

1. Make sure you have a SQL Server client installed on your computer. 

Parameter Value

Collation Setting SQL_Latin1_General_CP850_BIN

Sort order Binary

Security authentication SQL Server and Windows

Torn Page Detection Off

Parallelism Use one processor (do not use all available 
processors)
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2. Run the CustomDBView script.
3. Examine the log files for errors.

Installing the JDBC Driver in SQL Server
Gentran Integration Suite requires the correct Microsoft SQL Server driver. See System Requirements for 
supported version information. The supported version of the JDBC driver builds the correct Gentran 
Integration Suite directory structure.

Refer to one of the following sections for your Microsoft SQL Server version:

✦ Installing the JDBC Driver in SQL Server 2000 on page 16
✦ Installing the JDBC Driver in SQL Server 2005 on page 16

Installing the JDBC Driver in SQL Server 2000
Go to the Microsoft web site to download this driver, any appropriate patches, and the following .jar files. 
Be sure to place all the .jar files in the same directory.

✦ msbase.jar
✦ mssqlserver.jar
✦ msutil.jar files
After you obtain the JDBC driver file and .jar files, record the absolute path to their location on your system. 
You must supply this absolute path when you install Gentran Integration Suite. When you select these files 
during the installation, you can use one of the following methods:

Note: It is recommended that you use the first method (select all three files), because the second method 
(select a combined jar file) generates warning messages that might be confusing.

✦ In the browse window, select all three files by holding down the Ctrl key and clicking each file name.
✦ In the browse window, select a combined jar file, which you create using the following method:

a. Make a new directory in which you will work, and copy the separate jar files to this directory.
b. For each of the separate jar files, issue the following command:

jar -xvf jar_file_name

c. After all of the jars have been expanded, remove the META-INF directory that will be located in 
the working directory.

d. Create a new jar file by issuing the following command:
jar -cvf combinedJarName.jar *

Installing the JDBC Driver in SQL Server 2005
Go to the Microsoft web site to download the driver and any appropriate patches.

1. Download sqljdbc_version_language.exe to a temporary directory. 
2. Run sqljdbc_version_language.exe.
3. When prompted, enter an installation directory to which you will unpack zip file that contains the 

driver. It is recommended that you unpack the zip file in your Program Files directory with the default 
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directory Microsoft SQL Server 2005 JDBC Driver. You will access this directory path during the 
installation of Gentran Integration Suite.
Note: Make sure that you specify the full path to the installation directory. For example, C:\Program 
Files\Microsoft SQL Server 2005 JDBC Driver.
After the package unpacks, you can find out more information about using this driver by opening the 
JDBC Help System in the absolutePath\sqljdbc_version\language\help\default.htm file. This will 
display the help system in your Web browser. 

4. When the Gentran Integration Suite installation asks for the location of the JDBC drivers, specify the 
extracted jar file created after unpacking the archive (usually named sqljdbc.jar). The JDBC driver 
version is the same as the version of the drivers downloaded from Microsoft.

Configuring Snapshot for Microsoft SQL Server 2005
The snapshot feature in Microsoft SQL Server 2005 allows you to view a read-only copy of the database 
even when it is locked. It is recommended to configure snapshot feature as it reduces deadlocks. Run the 
following command to enable snapshot feature:

ALTER DATABASE db_name SET READ_COMMITTED_SNAPSHOT ON;

Installing DB2
You can use a DB2 database for maintaining information on Gentran Integration Suite. The following 
sections provide the necessary steps to install and configure a DB2 database for production.

To install DB2, do the following:

1. If you do not have DB2 installed, follow the installation procedures in your DB2 Installation manual.
Note: When creating the DB2 database, the appropriate codepage needs to be selected for international 
language characters (for example, UTF-8). 

2. Copy the jars to a well-known location for reference during installation.  The two jar files have to be 
repackaged as one file for the installer.  Unzip the files into a folder and rezip them as one jar file. 
Note: Various Gentran Integration Suite scripts, such as the one used for loading the factory defaults, 
specify a DB_Driver. The DB_Driver specified must include both of these JAR files. 

3. You need to set the following parameter to avoid memory leaks and DB2 crashes:
db2set DB2_NUM_CKPW_DAEMONS=0

DB2 Database User Privileges
The DBADM role is required for performing administrative operations in the DB2 database.

Configuring a DB2 Database for Production
You need to configure your DB2 database for running in a production environment with Gentran Integration 
Suite. To configure a DB2 database for a production environment, you must size the database by estimating 
the required disk space. It is not recommended to use multiple schemas in a database. If necessary, you can 
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create multiple databases (one per user) to prevent schema collisions. For more information, refer to 
Database Sizing on page 8.

Note: The installation script creates tables and indexes. Certain tables require a page size of 16K. You 
should have a tablespace to accommodate such tables. DB2 automatically places tables and indexes 
in the available tablespaces using its internal logic. You can move the tables to a different tablespace 
after the installation is complete.

Using a DB2 Database Server
You can use a DB2 database with Gentran Integration Suite. See System Requirements for supported version 
information. To use a DB2 server, follow this process:

✦ Create the database. Refer to the DB2 documentation for information about creating the database, 
including creating a schema repository, login, and tablespace. Be sure to install the correct version and 
patch. Be sure to install the client components and compilers before you install the fixpack.

✦ Configure the database by completing the following tasks:
Installing Client Components, Compilers, and Fixpack on page 18

Setting Parameters for DB2 on page 18

Granting Permissions for DB2 on page 19

Installing JDBC Drivers for DB2 on page 19

Installing Client Components, Compilers, and Fixpack
Gentran Integration Suite uses stored procedures for DB2. You must install or set up the following 
components:

1. Install the Administration client. 
2. Install Gentran Integration Suite Development clients.
3. Install the necessary fix pack after you install the client components and compilers. Otherwise, the 

clients will overwrite the fix pack binaries.
4. Set the path for the compiler by using the db2set command. 

For more information about these tasks, see the IBM documentation.

Setting Parameters for DB2
The following parameter settings are required in your DB2 database:

Parameter Value

APPLHEAPSZ greater than or equal to 10000

APP_CTL_HEAP_SZ greater than or equal to 512

MAXAPPLS greater than or equal to 150
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Granting Permissions for DB2
Grant DBADM permissions to the user.

Installing JDBC Drivers for DB2
For DB2, install the appropriate DB2 JDBC Type 4 driver and any correlating patches. See System 
Requirements for supported version information.

You can obtain these files from the IBM Web site. After you obtain this JDBC driver, record the absolute 
path to its location on your system. You must supply this absolute path during installation. 

If the JDBC driver provided by your database vendor is distributed among multiple files, you must place all 
the files that comprise the JDBC driver into one .jar file. Follow these steps to create one .jar file:

1. Identify all the vendor database jar files for the JDBC driver.
2. Create a temporary working directory (mkdir wd; cd wd).
3. Extract the contents of each file used for the JDBC driver using the jar utility into the temporary 

working directory (jar -xf \path\to\db2jcc.jar and jar -xf 
\path\to\db2jcc_license.jar).

4. Bundle the files in the temporary working directory into one file using the jar utility (jar -cf 
\path\to\new_db2_all.jar *). 

5. Record the absolute path to the .jar file you created on the Preinstallation Checklist.

The Type 4 driver does not require a separate Java listener running on the database server. Instead, connect 
directly to the DB2 port.

Using a MySQL Database Server (Non-Clustered Only)
Note: Only Windows non-clustered installations of Gentran Integration Suite can use the MySQL 

database.

You can choose to use the MySQL database server that is bundled with Gentran Integration Suite. Choosing 
this database during the installation procedure creates and configures it for you. MySQL is installed locally 
on the same server as Gentran Integration Suite and cannot be installed on a separate server.

LOCKLIST greater than or equal to 30000

MAXLOCKS 100

Database code page UTF-8

Parameter Value
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Managing Database Passwords
A password is used by the application to connect to its database. The password is stored as clear text in a 
property file on the system. If the security policies at your company require you to encrypt these passwords, 
you can do so after you install Gentran Integration Suite. Encrypting these passwords is optional.

Database Password Encryption Methods
Database passwords are encrypted using one of two methods, OBSCURED or ENCRYPTED. The 
encryption method is decided by the value of the encryptionPrefix in propertyEncryption.properties or 
propertyEncryption.properties_platform_security_ext file.

Encrypting Database Passwords (Windows)

To encrypt the database password: 

1. Stop the Gentran Integration Suite.

2. Navigate to \install_dir\install\bin.
3. Enter enccfgs.cmd.
4. Enter setup.cmd.
5. Enter deployer.cmd.
6. Enter startWindowsService.cmd to start the Gentran Integration Suite.

Decrypting Database Passwords (Windows)
To decrypt a password in Windows:

1. Stop the Gentran Integration Suite.
2. Navigate to \install_dir\install\properties.
3. Open the sandbox.cfg file.
4. Copy encrypted password from the database_PASS property. Use the text that appears after the 

database_PASS= text. For example, if database_PASS= OBSCURED:123ABCxyz321, you would 
copy the text OBSCURED:123ABCxyz321. (OBSCURED is the encryption method for the 
password.)

5. Navigate to \install_dir\install\bin.
6. Enter decrypt_string.cmd encrypted_password. For encrypted_password, use the text that you 

copied in Step 4.
You are prompted for the Sterling Integrator passphrase.
Your decrypted password appears.

7. Navigate to \install_dir\install\properties.
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8. Edit the sandbox.cfg file to replace the encrypted password with the password that was returned in 
Step 6.

9. You need to decrypt the entry for YANTRA_DB_PASS. Repeat Steps 4 to 8 to decrypt 
YANTRA_DB_PASS.

Note: You should also decrypt any custom database pool passwords present in the 
customer_overrides.properties file or any other properties file.

10. Navigate to \install_dir\install\bin.
11. Enter setupfiles.cmd.
12. Enter deployer.cmd.
13. Enter startWindowsService.cmd to start the Gentran Integration Suite.
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Chapter 3

Installing in a Clustered Windows
Environment

Caution: Gentran Integration Suite should be installed behind a company firewall for security purposes. 
See the Perimeter Server and Security topics in the Gentran Integration Suite documentation 
library for more information on secure deployment options.

Preinstallation Setup Checklist for a Clustered Windows 
Environment
The following topics will assist you with preinstallation tasks when planning to install Gentran Integration 
Suite in a clustered Windows environment:

Checklist for Windows Preinstallation on page 22
Checking System Requirements on page 25
Installing the Java 2 Software Development Kit on page 25
Downloading the JCE Distribution File on page 26
Determining Port Numbers on page 26
Obtaining a License File on page 27
Silent Installations on page 28
Installing the JDBC Driver in SQL Server on page 29

Checklist for Windows Preinstallation
The preinstallation checklist for the Windows environment identifies the prerequisite tasks you must 
complete before installing Gentran Integration Suite.

Note: When creating a name, such as an account name, permissions name, profile name, or database name, 
follow these conventions:

Use any valid alphanumeric characters and -, :, $, &, or _.
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Do not use spaces or apostrophes.

You may want to make a copy of the following checklist and use it to record the information you collect for 
installing Gentran Integration Suite:

Step Description Your Notes

1 Verify that your system meets the hardware and software 
requirements specified for this release. See Checking 
System Requirements on page 25.

2 Verify that your system has the patches required by 
Java™ for the Windows environment. See the vendor’s 
Java Web site for more information.

3 For systems with multiple IP addresses, verify that the IP 
address on which Gentran Integration Suite resides is 
accessible by any client computer that is running a 
browser interface.
Caution: If you do not verify the IP addresses, your 
system may not operate properly after installing Gentran 
Integration Suite.

4 Verify that all client computers are using Microsoft 
Internet Explorer 5.x or later.

5 If you are using a non-English environment, confirm that 
you are using the appropriate character set.

6 Determine and record information about the Java 2 
Software Development Kit (JDK). See Installing the Java 
2 Software Development Kit on page 25.

Version of the JDK.

Absolute path to the JDK files and patches. The path 
name cannot include spaces.

7 Obtain the JCE distribution file and record the absolute 
path to the zipped file. See Downloading the JCE 
Distribution File on page 26.

8 Determine and record the initial port number to be used 
by Gentran Integration Suite. See Determining Port 
Numbers on page 26.
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9 If you are using a SQL Server 2000/2005 database or an 
Oracle database, determine and record information 
about your database server. Be aware that this 
information is case sensitive.

Database vendor

Database user name and associated password

Database (catalog) name

Database host name

Database host port number

Absolute path and file name for the JDBC driver

Version of the JDBC driver

10 Determine and record information to set up default 
system alerts from Gentran Integration Suite:

The Administrative e-mail address to which system 
alert messages are sent. 

The SMTP Server IP address used for sending alert 
messages.

11 Determine and record the directory in which you plan to 
install Gentran Integration Suite.

The installation directory must not exist because the 
installation process creates it.

The installation directory must have adequate free 
disk space.

The name of the directory cannot include spaces and 
must be less than 30 characters long excluding 
separators, for example, C:\GIS_43\install_dir\install. 
Using a directory name of more than 30 characters 
could create an installation that is impossible to 
delete.

12 Determine and record the passphrase you want to use 
for Gentran Integration Suite system. 
During installation, you must enter the passphrase twice.

13 Obtain the license file and record the absolute path and 
file name to the license file. Be sure that the path name 
and the file name do not contain any spaces. See 
Obtaining a License File on page 27.
Note: For a cluster, you need to get a valid license for 

the IP addresses of all the nodes of the cluster. 
The license file includes spaces for more than 
one IP address.

Step Description Your Notes
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Checking System Requirements
Before you begin, verify that your system meets the hardware and software requirements specified for this 
release. The hardware requirements listed are the minimum required to run Gentran Integration Suite. Your 
system requirements will exceed these if you are running other applications on the same machine as Gentran 
Integration Suite. For current information, see the System Requirements posted on Gentran Integration Suite 
Documentation Library:

http://www.sterlingcommerce.com/Documentation/GIS43/homepage.htm

The installation strictly enforces the following system requirements:

Operating system version (must match requirement exactly)
The minimum patch level for the operating system is enforced, but you can apply higher patch levels.
JDK version (must match requirement exactly)
Disk space
The disk space is a minimum for the installation.  The system should be separately sized to handle 
whatever load is going to be put on the system.

Installing the Java 2 Software Development Kit
You must install the Java 2 Software Development Kit (JDK) and the patches specific to your system. To 
determine which JDK version and patches you need, see the System Requirements. After you install the 
JDK, record the path to the JDK for future reference.

Caution: Two registry keys written by the installation of the Sun JDK version 1.5.0-11 are faulty and 
include an invalid value for the JavaHome key (the Java JDK location). If the Gentran Integration 
Suite installation cannot find the Java JDK location using the registry settings, you are prompted 
for the location of the Java JDK directory. Once the installation is complete, the registry will be 
updated with the correct JDK location. 

14 Determine whether Gentran Integration Suite is using an 
application server (JBoss™, WebLogic® or 
WebSphere®).

Gentran Integration Suite does not require an application 
server for installation or at runtime. 

Gentran Integration Suite supports integration with JBoss 
and WebLogic during the installation. You can also 
integrate with WebSphere, JBoss, or WebLogic after 
installing version 4.3 by using the Gentran Integration 
Suite EJB Adapter. This does not represent a WebLogic 
server for deploying the Application Console.

Step Description Your Notes
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Downloading the JCE Distribution File
The Java Cryptography Extension (JCE) is a set of Java packages from Sun Microsystems, Inc. that provides 
a framework and implementations for encryption, key generation and key agreement, and Message 
Authentication Code (MAC) algorithms. 

Note: If you are installing Gentran Integration Suite outside of the United States, check to see if you can 
get the JCE unlimited strength jurisdiction policy files. The unlimited strength jurisdiction policy 
files can only be exported to countries to which the United States permits the export of higher-level 
encryption.

To obtain this file for the Sun JDK 1.5:

1. Open your browser and navigate to http://java.sun.com/javase/downloads/index_jdk5.jsp.
2. At the bottom of the page, locate Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction 

Policy Files 5.0 and click the Download button.
3. Download the jce_policy-1_5_0.zip file to your system. 
4. Once the file resides on your system, note the exact directory and file name for this zipped file. You 

will need this information during the installation process.

Determining Port Numbers
During installation, you are prompted to specify the initial port number for Gentran Integration Suite. For 
other ports, you can accept the default port number suggested by the installation program, or you can specify 
a different port number. To specify a port number, follow these guidelines:

Gentran Integration Suite requires a range of 100 consecutive open ports between 1025 and 65535. 
The initial port number represents the beginning port number in the range. 
The port range starts with the initial port number and ends with the number that equals the initial port 
number plus 100. All ports in this range must be available for Gentran Integration Suite. For example, 
if you specify 10100, then you need to make sure that 10100 through 10199 are not used by any other 
applications on your system.

All port assignments can be found in the install_dir\properties\sandbox.cfg.

HTTP ports are assigned in pairs to facilitate an HTTPS listener on the second port. The following ports are 
assigned:

B2B_HTTP_PORT= baseport+6 and baseport+7
WEBX_PORT= baseport+8 and baseport+9
SOAP_PORT= baseport+10 and baseport+11

Two ports (HTTP_SERVER_PORT and LIST_PORT) are required to access Sterling Secure Proxy from 
browsers. If you plan to configure Sterling Secure Proxy from a higher security network, you need both of 
these ports open in your firewall.
Sterling Commerce, an IBM Company 26



Preinstallation Setup Checklist for a Clustered Windows Environment
Obtaining a License File
After your company signed the sales contract with Sterling Commerce, Sterling Commerce created a license 
file containing information about your company, your system, and the packages (components), such as 
services, maps, and adapters, your company selected to use. 

The license file contains a license that is associated with your specific operating system and the IP address 
of your system. The license provides access, for 20 years from the date of issue, to Gentran Integration Suite 
packages your company selected and is independent of your maintenance fee. Because the license is 
independent of your maintenance fee, the schedule for renewing your license and license file may be 
different than the maintenance fee schedule. 

To run an Gentran Integration Suite cluster, you need to get a valid Gentran Integration Suite license for 
multiple IP addresses for all the nodes where Gentran Integration Suite will be installed and configured as 
a cluster. The license file includes space for more than one IP address.

You must download the license file before you can install Gentran Integration Suite. Follow these steps:

1. Point your Web browser to http://www.productupdates.stercomm.com.
2. Review the Welcome to Sterling Commerce Product Update page and click Next.
3. Review the Authenticate page and click Next.

4. Type the License File Key, which is case-sensitive, and click Next. If the system displays the Retrieve 
Registration dialog box and you are upgrading, you may retrieve your registration information by 
entering your previous License File Key. If you are not upgrading, then click Next.

5. Verify the registration information and click Next.
6. On the Server Details page, update the fields and click Next.

If the operating system, application server, or database server version is not listed in the respective 
lists, type the version in the respective Description of Other.
All IP addresses assigned to the server in which you are installing Gentran Integration Suite should be 
listed in the license file.

7. Verify the list of packages and the type of license selected for each package and click Next. If the list 
of packages selected or the type of license selected is not correct, then contact Customer Support to 
correct the information.

8. Scroll to the bottom of the Review and Download Package License File page and click Finish and 
Download.

9. Click Save in the File Download dialog box.
10. Accept the default location for the license file or navigate to the location where you will store the 

license file. Note the absolute path of the file location on the Preinstallation Checklist. You will need 
the absolute path to install Gentran Integration Suite.

11. Click Save.
12. Close your Web browser.
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Silent Installations
You can set up an installation of Gentran Integration Suite so that it runs with no user interaction. For these 
silent installations, you need to create the following items for your installation script:

A text file with information that during an interactive installation you are prompted to enter. This 
information is then automatically accessed by the installation script.
Examples of silent installation text file entries:
APSERVER_PASS = (system passphrase)

INSTALL_DIR = (full path to the installation directory)

LICENSE_FILE_PATH = (full path to the license file)

PORT1 = (initial port)

JCE_DIST_FILE = (full path to the JCE distribution file)

SI_ADMIN_MAIL_ADDR = (email address for administrative contact)

SI_ADMIN_SMTP_HOST = (SMTP mail server host name)

DB_VENDOR = (database - [MSSQL|MSSQL2005|Oracle])

ACCEPT_LICENSE = (license agreement acceptance - [yes/no])

DB_USER = (database user ID)

DB_PASS = (database password)

DB_DATA = ('net service name' or 'database name')

DB_HOST = (database hostname or IP address)

DB_PORT = (database's listener port.)

DB_DRIVERS = (fully qualified path to the database driver)

DB_DRIVERS_VERSION = (version of database drivers)

In a clustered installation, the text file must include the following line for nodes 2 and higher. This 
prevents these nodes from changing the database.
REINIT_DB = false

A reference in your installation script to this variable file. 
Windows silent installation files must delimit all colons (:) and backslashes (\) with a backslash. For 
example, INSTALL_DIR=C\:\\path\\for\\install directory
Also, Windows silent installation files must use the -noinstallshield argument in the command.
Example (node 1):
install_dir\\JDK\\bin\\java -jar GISxx.jar -noinstallshield -f 
silent_install_file

Example (nodes 2 and higher):
install_dir\\JDK\\bin\\java -jar GISxx.jar -cluster -noinstallshield -f 
silent_install_file
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Installing the JDBC Driver in SQL Server
Gentran Integration Suite requires the correct Microsoft SQL Server driver. See System Requirements for 
supported version information. The supported version of the JDBC driver builds the correct Gentran 
Integration Suite directory structure.

Refer to one of the following sections for your Microsoft SQL Server version:

Installing the JDBC Driver in SQL Server 2000 on page 29
Installing the JDBC Driver in SQL Server 2005 on page 29

Installing the JDBC Driver in SQL Server 2000
Go to the Microsoft web site to download this driver, any appropriate patches, and the following .jar files. 
Be sure to place all the .jar files in the same directory.

msbase.jar
mssqlserver.jar
msutil.jar files

After you obtain the JDBC driver file and .jar files, record the absolute path to their location on your system. 
You must supply this absolute path when you install Gentran Integration Suite. When you select these files 
during the installation, you can use one of the following methods:

Note: It is recommended that you use the first method (select all three files), because the second method 
(select a combined jar file) generates warning messages that might be confusing.

In the browse window, select all three files by holding down the Ctrl key and clicking each file name.
In the browse window, select a combined jar file, which you create using the following method:
a. Make a new directory in which you will work, and copy the separate jar files to this directory.
b. For each of the separate jar files, issue the following command:

jar -xvf jar_file_name

c. After all of the jars have been expanded, remove the META-INF directory that will be located in 
the working directory.

d. Create a new jar file by issuing the following command:
jar -cvf combinedJarName.jar *

Installing the JDBC Driver in SQL Server 2005
Go to the Microsoft web site to download the driver and any appropriate patches.

1. Download sqljdbc_version_language.exe to a temporary directory. 
2. Run sqljdbc_version_language.exe.
3. When prompted, enter an installation directory to which you will unpack zip file that contains the 

driver. It is recommended that you unpack the zip file in your Program Files directory with the default 
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directory Microsoft SQL Server 2005 JDBC Driver. You will access this directory path during the 
installation of Gentran Integration Suite.
Note: Make sure that you specify the full path to the installation directory. For example, C:\Program 
Files\Microsoft SQL Server 2005 JDBC Driver.
After the package unpacks, you can find out more information about using this driver by opening the 
JDBC Help System in the absolutePath\sqljdbc_version\language\help\default.htm file. This will 
display the help system in your Web browser. 

4. When the Gentran Integration Suite installation asks for the location of the JDBC drivers, specify the 
extracted jar file created after unpacking the archive (usually named sqljdbc.jar). The JDBC driver 
version is the same as the version of the drivers downloaded from Microsoft.

Installing in a Clustered Windows Environment
Installing Gentran Integration Suite cluster nodes is similar to a standard Gentran Integration Suite 
installation, with the following restrictions on all nodes:

All nodes must use the same database.
All nodes must use the same passphrase.
You must install and start the nodes sequentially, one at a time, starting with the first node.

Note: Clustering is not supported for Gentran Integration Suite systems that use the MySQL database.

Note: The following instructions assume that you received an installation CD for Gentran Integration 
Suite. If you downloaded Gentran Integration Suite or a Service Pack (SP) from the Electronic 
Software Distribution (ESD) Portal, unzip the downloaded file to an empty directory. Do not change 
the directory structure of the newly unzipped files. The directory containing the unzipped files is an 
electronic image of an installation CD. Use this directory wherever there is a reference to the 
installation CD in the following instructions. Ignore any instructions to place the installation CD in 
a drive.

To install Gentran Integration Suite in a clustered Windows environment, refer to your preinstallation 
checklist and follow the steps below.

Note: To install more than one instance of Gentran Integration Suite on the same Windows server, you 
must install the second instance in a different directory and use a different initial port number. This 
second port number must be at least 100 higher or lower than the first port number.

Note: During the installation, various messages are displayed, including some warning messages. These 
warning messages require no action on your part and are included so that helpful data is recorded in 
the log file.

1. Close all open Windows programs and any command prompt windows.
2. Insert Gentran Integration Suite installation CD in the appropriate drive.
3. On the installation CD, navigate to the windows\install folder.
4. Double-click setup.exe. Then click Next to start the installation program.
5. Review the license agreement, and click Yes to accept the terms.
Sterling Commerce, an IBM Company 30



Installing in a Clustered Windows Environment
6. The installation program searches for the JDK, using the registry settings. If the program cannot find 
the JDK location using the registry settings, you are prompted for the location of the JDK directory. 
Use the Browse button to search for the directory. For more information, refer to the caution 
information in Installing the Java 2 Software Development Kit on page 25.
Click Next.

7. You are prompted to choose an installation directory for Gentran Integration Suite. Click Browse and 
navigate to the folder you want to use as the installation directory. This directory is referred to as 
install_dir in subsequent prompts.
Note: The name of the directory cannot include spaces and must be less than 30 characters long 
excluding separators, for example, C:\GIS_43\install_dir\install. Using a directory name of more than 
30 characters could create an installation that is impossible to delete.

8. You are prompted to browse to the location of the license file. Select the license file, and click Next. 
If you have not installed a license file, you can minimize this window, obtain the license file, and then 
return to the installation process.

9. You are prompted to browse to the location of the JCE distribution file. Select the JCE distribution file, 
and click Next. The program verifies the path name.

10. A screen appears with the following four checkboxes:

I want to install a cluster node 2 or higher

Select this box only when installing node 2 or higher of the cluster.

I want to upgrade from a prior version

Select this box only when upgrading from a prior version of Gentran Integration Suite.

I want to enable FIPS mode

Select this box if you are enabling the Federal Information Processing Standards (FIPS) mode.

I want GIS to automatically create the database schema

This checkbox is selected by default. Make sure that it is selected, as the option of manually 
creating the database schema is not supported on the Windows environment.

After choosing your checkbox option, click Next
11. The system displays a command window. Leave the command window open. You can minimize the 

command window, but do not close it or the installation program cannot prompt you for information or 
display status messages.

12. The system displays a message window listing information you will need in subsequent steps. Click 
OK to continue.

13. You are prompted about overriding the host IP address for this installation.

To accept the default host IP address, click Next.

To specify another host IP address, enter the IP address you want to use. Click Next.

Note: If you are installing Gentran Integration Suite on VMware, you should provide the IP address of 
the virtual machine and not of the VMware host. For example, if 10.251.124.160 is the IP address of 
the VMware server and 10.251.124.156 is the IP address of the Windows 2003 server it is hosting, you 
should use 10.251.124.160 as the IP address to install Gentran Integration Suite.
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14. Type the administrative e-mail address to which you want system alert messages to be sent. Click 
Next.

15. Type the SMTP mail server host name that you want to use for alert messages. Click Next.
16. Type your system passphrase in both the Passphrase box and the Confirm box. Click Next. 
17. Type the initial port number for Gentran Integration Suite server and click Next. 

The installation creates subsequent ports based on the initial port number. These port assignments are 
written to the install_dir\properties\sandbox.cfg file.

18. Select the database you want to use and click Next.
Note: Clustering is not supported for Gentran Integration Suite systems that use the MySQL database.

If you select Microsoft SQL Server 2000 or 2005, enter the following information and click Next:

• Database host name
• Database host port number
• Database name
• User ID
• Password
• Password confirmation

If you select Oracle, you are asked whether the Oracle instance is being used for an upgrade. 
Answer No.
Enter the following information and click Next:
• Database host name
• Database host port number
• Database name
• User ID
• Password
• Password confirmation

19. If you selected Oracle or either version of Microsoft SQL Server as your database, verify that you have 
the required JDBC drivers installed.
a. Verify that you have the required JDBC driver file copied to a local folder on your computer. Use a 

descriptive name for this folder that will help you later access the driver.
b. Browse to the location of the JDBC driver file. Select the file and click Open. For more 

information about how to select the file for Microsoft SQL Server, refer to Installing the JDBC 
Driver in SQL Server on page 29.

c. In the Version Number field, type x_x and click Next. Refer to System Requirements for the 
actual version number.

20. Click Yes to proceed with the installation. 
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21. The installation completes automatically. When the installation is finished, the system places an icon 
on your Windows desktop and displays a message that Gentran Integration Suite was successfully 
installed. Click OK. Click Next. Click Finish.
If you encounter problems or errors during installation, see the section Troubleshooting: Windows 
Environment.

22. Starting from node 2, start the installation as normally done for all Gentran Integration Suite 
installations. Use the windows\install\setup.exe command as the primary method of 
installation.
Use the command line as the secondary method of installation:
Java -jar GIS.jar -cluster

For a silent installation, type:
Java -jar GIS.jar -f silent.install -cluster

For more information about silent installations, refer to Installing the JDBC Driver in SQL Server on 
page 29.

23. When prompted, select all options that apply to your installation. 
Select the checkbox to indicate that you are installing a cluster on node 2 or higher. Do not select the 
box indicating an upgrade from a prior version. Your installations on node 2 or higher will use the 
database that was installed for node 1, so you do not need to use the upgrade option for node 2 or 
higher.

Note: The database schema is only built once. When installing a cluster on node 2 and higher, you must 
ensure I want GIS to automatically create the database schema is selected even though it does not 
create a second database schema.

24. Click Next.
The following message appears:
Please wait while Setup bootstraps Gentran Integration Suite install..
After bootstrap completes you will get a message notifying what you will require to proceed further 
(application port number and database server information).
Note: You need to use the same database that you used for the installation in Step 1.

25. Click Next.
26. Complete the rest of the installation process as normally done for a Windows Gentran Integration Suite 

installation, but do not start the Gentran Integration Suite instances.
After all nodes are installed, go to the next step.

27. (If installing multiple nodes on the same machine) Go to the install_dir\properties directory of nodes 2 
and higher and change the mcast_port property in jgroups_cluster.properties.in to point to the value of 
node 1’s mcast_port property in jgroups_cluster.properties. 
Note the different property file names:

jgroups_cluster.properties (node 1)
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jgroups_cluster.properties.in (nodes 2 and higher)

a. (IPv6 only) For all nodes, change mcast_property from 239.255.166.17 to FFFF:239.255.166.17.
b. (IPv6 only) In the sandbox.cfg file, add HOST_ADDR=<IPv6_hostname>.

28. (If installing multiple nodes on the same machine) Go to the install_dir\properties directory of nodes 2 
and higher and change the multicastBasePort property in noapp.properties.in to point to the value of 
node 1’s multicastBasePort property in noapp.properties.
Note the different property file names:

noapp.properties (node 1)

noapp.properties.in (nodes 2 and higher)

29. On each node, starting with node 1, perform cluster configuration by running the command 
startCluster.cmd nodeNumber from the Gentran Integration Suite install_dir\bin directory 
where nodeNumber is the sequential number assigned to each node starting with 1.
For example, use the following commands on the first two nodes:
a. startCluster.cmd 1

b. startCluster.cmd 2

Note: You should run startCluster.cmd command only after you install Gentran Integration Suite. You 
should not run startCluster.cmd command when you restart a Gentran Integration Suite 
instance. However, if you have installed a patch or a hot-fix, refer Custom Configurations on page 
35 to start the cluster without updating the database settings.

30. Bring up all instances of Gentran Integration Suite by running startWindowsService.cmd from 
the install_dir\bin directory for each instance, starting with the first node.

To dynamically add new nodes to the cluster, install the new node in the same way that you installed node 
2 in a new cluster installation. Run the startCluster.cmd command with the new node number.

Cluster Setup (Windows)
The following sections explain how to set up a cluster installation after installing or upgrading all nodes of 
the cluster.

Multiple Nodes
Gentran Integration Suite supports the installation of multiple nodes on the same machine. Each node will 
be configured on a different port range. Install the second node on the same machine on a different port 
range following the installation instructions discussed in the previous section. Once the installation is 
complete and cluster setup is complete, go to the properties directory of the node installed and change the 
multicastBasePort property in noapp.properties.in to point to node1's multicastBasePort. After changing 
this property, run the setupfiles.cmd command.
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Custom Configurations
As part of a default cluster configuration, certain values in the database for service or adapter configurations, 
default document storage type, etc., are updated to get the cluster working. The default settings include no 
shared or mounted file system available with “line of sight” from all cluster nodes, etc. Certain service or 
adapter configurations are forcibly deployed on node1 and default document storage type is set up to 
“Database” for all business processes.

After you install the cluster and evaluate the customer configurations and requirements, the above 
conditions might change and custom configurations will be incorporated. To keep these custom 
configuration changes from being overwritten, the following cluster configuration script has an option to 
update the database:

startCluster.cmd nodeNumber true\false

nodeNumber is the cluster node number
Type true to perform database update and false to prevent any database updates.

The first time you configure a cluster, run startCluster.cmd with the database update option set to true 
to have all cluster-related configurations take effect.

startCluster.cmd nodeNumber true

For cluster configurations after the first configuration, you can execute the startCluster.cmd command 
with the database update option turned off. This prevents any configuration changes from affecting the 
system, especially after installing patches/hot-fixes.

startCluster.cmd nodeNumber false

Node to Node Communications
Cluster nodes are configured to communicate with each other using JGroups, an open source toolkit that 
provides flexibility for protocol configuration. JGroups provides rich open management features, along with 
multiple protocol support. JGroups supports multicast (UDP) and TCP-based communication protocols.

When JGroups is configured to use multicast (UDP), all cluster nodes communicate with each other on a 
specific IP address and port. The multicast ports are configured based on the installation base port. All 
clusters that are on the same subnet configured on the same base port will end multicasting messages on the 
same multicast IP address and port. 

When JGroups is configured to use multicast (UDP), all cluster nodes communicate with each other on a 
specific IP and port. The multicast ports are configured based on the installation base port. All clusters that 
are on the same subnet configured on the same base port will end multicasting messages on the same 
multicast IP address and port. 

To avoid this, each Gentran Integration Suite cluster on the same subnet needs to be configured on different 
base ports.  Install your clusters on different port ranges or on different network segments with multicast 
forwarding restricted, so that they will not interfere with each other. The default multicast address used in 
Gentran Integration Suite release 4.3 is 239.255.166.17. This address is configurable, with a port range of 
10 ports, starting with the multicast base port for the instance.

All nodes participating in the same cluster must be installed on the same multicast base port (the 
multicastBasePort property in the noapp.properties file).  This is usually computed from the system base 
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(non-multicast) port, but can be configured separately in the noapp.properties file, to allow different nodes 
in a cluster to be installed at different (non-multicast) port ranges.  Also, all the nodes in the cluster should 
be installed in the same subnet.

For node to node communications, the properties are defined in jgroups_cluster.properties. The attributes 
used to define communications are:

property_string - default value is UDP

distribution_property_string - default value is TCP. This attribute should never be set to UDP.

If you want to change the communication for cluster multicast from TCP to UDP, contact Gentran 
Integration Suite Support. In addition, if you are using TCP for both property_string and 
distribution_property_string, the initial_hosts list for TCPPING should contain all hosts in the cluster.

For more information about UDP, TCP and JGroups communications, refer to the Gentran Integration Suite 
4.3 Clustering documentation.

Configuring Shared File System as Document Storage
In a cluster, the default document storage is database, so that all of the nodes in the cluster have line of sight 
to the documents to access and process the documents. However, using the database for document storage 
has performance implications over using the file system for document storage. 

To use the file system as document storage in a cluster, the file system needs to be a 
shared/mounted/clustered file system with all nodes having line of sight to the file system. Have your system 
administrator set up the shared/mounted/clustered file system. 

For each node, follow this procedure to configure a shared file system in a cluster:

1. Go to the install_dir\properties directory.
2. Change the document_dir property in jdbc.properties.in to point to the shared file system directory 

configured to store the documents.
3. Run the setupfiles.cmd command in the install_dir\bin directory.
4. Restart Gentran Integration Suite (all nodes).

This configures a shared file system directory as document storage.

Cluster Environment Verification
This section explains the verification process for the cluster environment.

Verify the following properties:
The property CLUSTER=true is included in the install_dir\properties\sandbox.cfg file.

The cluster property in centralops.properties and noapp.properties is true and the clustered_env 
property in ui.properties is set to true
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Using the System Troubleshooter, you can verify the cluster environment by viewing the following 
information for each node:
a. Queue information 
b. JNDI Tree for each node
c. Host, state, status, adapters, and memory usage information
d. Perimeter Server
e. Shows adapter status for each node with a dropdown box listing all nodes in cluster  
Select Operations > System > Troubleshooter to display all the cluster nodes, ops URL, node URL, 
the status of the node and which node holds the token.
You can track errors and exceptions in the system by selecting Operations > System > Logs. In a 
clustered environment, the logs are provided for each node. A dropdown list shows all the nodes. By 
selecting the node, the logs corresponding to the nodes are displayed. You can see each log item in this 
page for each node after all nodes start.
The Activity Monitor UI provides the status of running business process and scheduled services. Using 
this feature, you can monitor all service activities including the node on which each activity is 
executing.
To display the current threads that are running on specific node, select Operations > System > 
Troubleshooter, and then select the Threads for a node.

Starting or Stopping the Cluster Environment
Note: To run a cluster, you need to get a valid Gentran Integration Suite license for multiple IP address of 

all the nodes where Gentran Integration Suite will be installed and configured as a cluster.

You can start the cluster environment by running the following command on each node, starting with node1 
(it is recommended to start node 1 first.):

startWindowsService.cmd

If you are restarting the entire cluster, please run the following commands:

Node 1:
startWindowsService.cmd restart

This option is used for cleaning the cluster data, settings, and so on to do a clear start.

Nodes 2 and higher:
startWindowsService.cmd

You can stop a cluster by using one of the following options:

The hardstop.cmd command from each node. This stops all Windows Services for each node.
The softstop.cmd command from each node. This does a regular cleanup and shutdown of all 
components.

Caution: Running softstop.cmd command in a multiple node (clustered) environment will suspend all 
scheduled business processes.  It is recommended to run the hardstop.cmd command when 
stopping individual nodes of a cluster.
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Shut down the whole cluster by selecting Operations > System > Troubleshooter, and then clicking 
the Stop the System link.
Shut down specific nodes by selecting Operations > System > Troubleshooter, and then clicking the 
shutdown link.

Patches and Hot-Fixes (Cluster)
The following sections explain how to update Gentran Integration Suite, using the following methods:

Installing the Current Maintenance Patch (Cluster) on page 38
Patches contain cumulative fixes for a specific version of Gentran Integration Suite. Because each 
patch contains the fixes from previous patches, you only need to install the most recent patch. 
Installing a Hot-Fix (Cluster) on page 44
A hot-fix is one or more fixes applied to a specific existing patch.

Installing the Current Maintenance Patch (Cluster)
Patches contain cumulative fixes for a specific version of Gentran Integration Suite. Because each patch 
contains the fixes from previous patches, you only need to install the most recent patch. 

Note: During patch installation, the dbVerify utility compares the list of standard indexes with those 
present in the database and drops the custom indexes. You should recreate the custom indexes after 
the patch installation is complete.

All nodes in a cluster must be patched to the same level. You should stop all nodes in the cluster before 
installing a patch and then install the patch on each node but in some cases, you can apply patches to nodes 
while others are still processing. A patch containing any of the following requires the entire cluster to be 
down:

Critical cluster functionality
Engine-related changes
Changes to the database

Attempting to apply patches while part of the cluster is running should only be done with the advice of 
Sterling Commerce Customer Support.

Before installing the patch, refer to to the following sections for more information about working with the 
different nodes of a cluster during a maintenance patch installation:

Applying a Patch in a Clustered Environment Stopping the Whole Cluster on page 39
Applying a Patch in a Clustered Environment Stopping One Node at a Time on page 40

To help you determine which patch to use, the files are named using the following naming convention: 

si_43_build_build number.jar (for example, si_43_build_4307.jar)

Information about a patch is located in a PDF file with a similar name. The naming convention for PDF files 
containing information about a particular patch is:
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si_43_build_build number_patch_info.pdf (for example, si_43_build_4307_patch_info.pdf)

Both the .jar and the .pdf files are available on the Sterling Commerce Support on Demand Web site, at 
https://support.sterlingcommerce.com. You should periodically check the web site to verify that you have 
the most recent patch.

Note: The patch installation may use one or more patch property override files. These files will be named 
propertyFile_patch.properties. Do not alter these files.
Additionally, property changes made directly in .properties or .properties.in files may be overridden 
during the patch installation. Properties overridden using the customer_overrides.properties file are 
not affected.

Applying a Patch in a Clustered Environment Stopping the Whole Cluster
For a critical patch where the whole cluster needs to be down, use the following process:

1. Go to the Sterling Commerce Support on Demand Web site, at https://support.sterlingcommerce.com.
2. Download the most recent patch file for your version of Gentran Integration Suite and record the 

absolute path to the downloaded file. If you use FTP, use Binary mode. Do not rename the file. Make 
sure that you download the file to your local machine (for example, to your installation bin directory), 
and not to a network drive. Use the full path to your local machine when you install the patch.

3. Verify that the database server is up and ready to accept connections.
4. Stop all nodes of the cluster.
5. Perform a full backup of Gentran Integration Suite installation directory, including all subdirectories. 

Also back up your database.
6. If your database password is encrypted, decrypt the password. For more information about decrypting 

database password, refer Decrypting Database Passwords (Windows) on page 20.
7. If you edited any property files, update the customer_overrides.properties file with these changes. This 

will keep the edited property files from being overwritten with the contents of the associated 
initialization (*.properties.in) files during the patch installation. Please refer to the documentation on 
configuring overrides to properties files.

8. Close all command prompt windows.
9. Install the patch using the following commands:

a. Open a command prompt window.
b. Change to the directory where Gentran Integration Suite is installed and run the following 

command:
installDir\bin

c. Run the following command to install the patch:
InstallService.cmd 
<path>\si_<version>_sp_0_patch_<number>_<app_server>.jar

where:
<path> = Fully qualified path to maintenance patch file
<version> = Gentran Integration Suite Version
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<number> = Patch number
<app_server> = Application Server
Example: InstallService.cmd c:\patch\si_22_sp_0_patch_1_jboss.jar

Apply the patch to node 1 first, and then to the subsequent nodes: node 2, node 3, etc. For node 1, 
REINIT_DB is true in sandbox.cfg. For subsequent nodes, REINIT_DB is false, which prevents 
database updates from repeating on each node's patch installation. This is automatically set during the 
patch installation for all nodes except node 1 if the installation is done using the nodbinit option.
Information about the patch installation is automatically logged to install_dir/logs/InstallService.log.
If the patch attempts to modify the database schema and the modification fails, you will receive an 
error message about the failure. The message provides the error message code from the database and 
the SQL command that failed. The failure information is also logged to the system.log file and to the 
patch.log file.

10. If you decrypted the database password, re-encrypt the password. For more information about 
encrypting database password, refer Encrypting Database Passwords (Windows) on page 20.

11. For each node, run the startCluster.cmd nodeNumber command to reconfigure the cluster 
environment after installing the patch.
For more information about using the startCluster.cmd command, refer to Updating the 
Database (dbupdate) with the startCluster Command on page 42.
Note: Ensure that you run startCluster.cmd nodenumber false command to prevent 
configuration changes that may affect the system. Refer to Custom Configurations on page 35 before 
configuring the cluster environment.

12. Restart Gentran Integration Suite.

If you are using a perimeter server in a DMZ, see Installing Patches in a Perimeter Server Clustered 
Windows Environment on page 50.

Applying a Patch in a Clustered Environment Stopping One Node at a Time
For a patch where you can stop the cluster one node at a time, use the following procedure:

Note: Apply the patch to node 1 first, and then to the subsequent nodes: node 2, node 3, etc.
1. Go to the Sterling Commerce Support on Demand Web site, at https://support.sterlingcommerce.com.
2. Download the most recent patch file for your version of Gentran Integration Suite and record the 

absolute path to the downloaded file. If you use FTP, use Binary mode. Do not rename the file. Make 
sure that you download the file to your local machine (for example, to your installation bin directory), 
and not to a network drive. Use the full path to your local machine when you install the patch.

3. Verify that the database server is up and ready to accept connections.
4. Shut down node 1 using the hardstop.cmd command.

Wait until the perimeter server of the node is completely down before installing the patch.
5. Perform a full backup of Gentran Integration Suite installation directory, including all subdirectories. 

Also back up your database.
6. If your database password is encrypted, decrypt the password. For more information about decrypting 

database password, refer Decrypting Database Passwords (Windows) on page 20.
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7. If you edited any property files, update the customer_overrides.properties file with these changes. This 
will keep the edited property files from being overwritten with the contents of the associated 
initialization (*.properties.in) files during the patch installation. Please refer to the documentation on 
configuring overrides to properties files.

8. Close all command prompt windows.
9. Install the patch using the following commands:

a. Open a command prompt window.
b. Change to the directory where Gentran Integration Suite is installed and run the following 

command:
installDir\bin

c. Run the following command to install the patch:
InstallService.cmd 
<path>\si_<version>_sp_0_patch_<number>_<app_server>.jar

where:
<path> = Fully qualified path to maintenance patch file
<version> = Gentran Integration Suite Version
<number> = Patch number
<app_server> = Application Server

Example: InstallService.cmd c:\patch\si_22_sp_0_patch_1_jboss.jar
For node 1, REINIT_DB=true in sandbox.cfg. For subsequent nodes, REINIT_DB=false, which 
prevents database updates from repeating on each node's patch installation. This is automatically set 
during the patch installation for all nodes except node 1 if the installation is done using the nodbinit 
option.
Information about the patch installation is automatically logged to the 
install_dir\logs\InstallService.log file.
If the patch attempts to modify the database schema and the modification fails, you will receive an 
error message about the failure. The message provides the error message code from the database and 
the SQL command that failed. The failure information is also logged to the system.log file and to the 
patch.log file.

10. If you decrypted the database password, re-encrypt the password. For more information about 
encrypting database password, refer Encrypting Database Passwords (Windows) on page 20.

11. Run the startCluster.cmd 1 command to reconfigure the cluster environment after installing the 
patch.
For more information about using the startCluster.cmd command, refer to Updating the 
Database (dbupdate) with the startCluster Command on page 42.
Note: Ensure that you run startCluster.cmd nodenumber false command to prevent 
configuration changes that may affect the system. Refer to Custom Configurations on page 35 before 
configuring the cluster environment.
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12. Open the install_dir\properties\sandbox.cfg file in a text editor. Perform the following steps:
a. If REINIT_DB is true, back up the sandbox.cfg file and change REINIT_DB to false.
b. Save and close the sandbox.cfg file.
This prevents database updates from being repeated for each node.

13. Repeat this procedure for each subsequent node.
14. Restart Gentran Integration Suite.

If you are using a perimeter server in a DMZ, see Installing Patches in a Perimeter Server Clustered 
Windows Environment on page 50.

Updating the Database (dbupdate) with the startCluster Command
The startCluster.cmd nodeNumber command on node 1 will automatically update the database, 
unless you use the command startCluster.cmd 1 false. The startCluster.cmd nodeNumber 
command on all other nodes will not update the database.

When you configure the Gentran Integration Suite cluster for the first time, you should run the 
startCluster.cmd command with the database update value set to true (startCluster.cmd 1 
true), or just startCluster.cmd 1, since on node 1, dbupdate defaults to true. This makes all 
cluster-related configurations take effect. The database update will synchronize the scheduled jobs between 
the nodes by assigning them all to node 1.

The startCluster.cmd command with the database update value turned off (startCluster.cmd 1 
false) prevents any configuration changes from affecting the system, especially after you install patches 
or hot-fixes.

For current database updates, the following services are tied to node 1:

Schedule
FileSystem
CmdLine
CDServerAdapter
CDAdapter
CDRequesterAdapter
CEUServerAdapter
HttpServerAdapter
B2B_HTTP_COMMUNICATIONS_ADAPTER
HTTP_COMMUNICATIONS_ADAPTER
HTTPClientAdapter
FTPClientAdapter
FtpServerAdapter
SFTPClientAdapter

The default storage of the following services is set to the database:

HttpServerAdapter
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CEUServerExtractServiceType
CDSERVER_ADAPTER

The default storage of all business processes is set to the database.
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Running a DB2 Schema Change Script
After you install Gentran Integration Suite, Release 4.3 build 4316 or later, run the fix_db2_schema.sql 
script. If you are using DB2 as a remote host for Gentran Integration Suite, running fix_db2_schema.sql 
script applies new schema changes and fixes SQL exception error that may occur during large file transfers.

To run fix_db2_schema.sql script:

1. Install Gentran Integration Suite, Release 4.3 build 4316 or later.
2. Apply the new schema changes by running fix_db2_schema.sql script.

cd <install_dir>\bin db_execFile.cmd –i 
<install_dir>\bin\sql\fix_db2_schema.sql -o <output_file> -j -s -p

The script will:

Rename the affected tables and indexes

Recreate the affected tables and indexes with the correct datatypes.

Migrate the data from the renamed tables to the recreated tables.

3. After verifying the changes, run drop statements to drop the old tables.

The old tables can remain in the system, but occupies additional database space. The 
fix_db2_schema.sql script contains commented statements to drop the affected tables. It is 
recommended to run these statements manually after verifying that data was migrated successfully.

Installing a Hot-Fix (Cluster)
After you install Gentran Integration Suite, you may need to install a hot-fix. A hot-fix is one or more fixes 
applied to a specific existing patch.

Before Installing a Hot-Fix
Before you can install a hot-fix developed for your company, you must have completed the following:

Received the case ID number from Sterling Commerce Customer Support
Created a full backup of Gentran Integration Suite 
Created a full backup of your database

Hot-Fix Installation
To install a hot-fix on the Windows host system:

1. Is the password encrypted? If Yes, decrypt the password. For more information about decrypting 
database password, refer Decrypting Database Passwords (Windows) on page 20.
Apply the hot-fix to node 1 first, and then to the subsequent nodes: node 2, node 3, etc. For node 1, 
REINIT_DB is true in install_dir\install\properties\sandbox.cfg. For subsequent nodes, REINIT_DB 
is false, which prevents database updates from repeating on each node's hot-fix installation.

2. Open a command line session. Click the Windows Start menu and select Programs > Accessories > 
Command Prompt.
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3. At the command line, type ftp theworld.stercomm.com.
4. Type your user name and password. If you do not know your user name and password, contact Sterling 

Commerce Customer Support.
5. Type bin and press Enter to select Binary as your transfer mode.
6. At the FTP prompt, type get ccaseid.jar, where caseid is the ID you received from Customer 

Support.
7. Shut down Gentran Integration Suite.
8. Open a command prompt and change the directory to install_dir\bin.
9. Type InstallService path to ccaseid.jar\ccaseid.jar to install the hot-fix.
10. If you decrypted the password in step 1, re-encrypt the password. For more information about 

encrypting database password, refer Encrypting Database Passwords (Windows) on page 20.
11. In the command prompt, change the directory to install_dir\bin.
12. Type uninstallWindowsService.cmd and log off. This removes previous Gentran Integration 

Suite Windows services from the Windows cache.
13. At the command prompt, type your user name and password.
14. Change the directory to install_dir\bin.
15. Type installWindowsService.cmd to install Gentran Integration Suite Windows services.
16. Restart Gentran Integration Suite. 
17. In the install_dir\bin directory, run dump_info.cmd to verify that the hot-fix was successfully 

installed. The successful running of dump_info.cmd will display the Gentran Integration Suite 
version number.

18. After installing the hot-fix, run the startCluster.cmd nodeNumber command to configure the 
node to a cluster node. For example, if a node was node 2 before the hot-fix, run the 
startCluster.cmd 2 command.
Note: Ensure that you run startCluster.cmd nodenumber false command to prevent 
configuration changes that may affect the system. Refer to Custom Configurations on page 35 before 
configuring the cluster environment.

Hot-Fix Package Delivery Method
The hot-fix package delivery method has changed effective Gentran Integration Suite, Release 4.3 Build 
4324 onwards. The hot-fix package will be delivered as a jar file that contains only the files that were 
modified. However, the installation procedure for a hot-fix remains the same. Refer to Hot-Fix Installation 
on page 44 for hot-fix installation procedure.

The following list describes the features of the new hot-fix package model:

Modified components are packaged as an installable file (jar).
Hot-fix version is maintained in the hotfix.properties file. It does not update the SI_VERSION table.
Run dumpinfo.cmd command to display the hot-fix version. You can also verify the hot-fix version 
in Gentran Integration Suite Support user interface page.
Size of the hot-fix package is small.
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Hot-fix must be installed on the same build version that was used to build it. For example, if a test 
system is on Gentran Integration Suite, Release 4.3 Build 4324 and the hot-fix is built for 4324, it can 
be installed on that test system. However, if the production system is on Gentran Integration Suite, 
Release 4.3 Build 4323, you must apply Gentran Integration Suite, Release 4.3 Build 4324 prior to 
applying the hot-fix.
You can locate the hot-fix read me file in the Gentran Integration Suite root (install_dir) directory. For 
example, install_dir\hotfix_readme.txt.
If you have Sterling File Gateway installed in your environment, the hot-fix for Sterling File Gateway 
is installed automatically.

Performing Checksum using DB Checksum Tool
A checksum is a simple redundancy check used to detect errors in data. In Gentran Integration Suite 4.3, a 
verification process is used to compare the checksum between the existing default resource and the resource 
added after applying a patch or upgrading. The DB Checksum tool, a resource difference tool generates a 
granular report of the changes in the system that was not permitted to be set as defaults.

The DB Checksum tool generates the difference in resource checksum between the default resource and the 
latest system resource from the database.

To run DB Checksum tool, do the following:

1. Navigate to the <install_dir>\bin directory.
2. Run the following command from the <install_dir>\bin directory:

db_checksum_tool.cmd [-d] [-i [1 | 2 | 3 | 4 | 5]] [-r [wfd | map | schema | 
sii | template]] [-o <output file>] [-g] [-h]

where:
-d is the mode to dump the difference of resource checksum between the default resource and latest 
system resource.
-i is the resource type integer (optional).

1 is WFD
2 is MAP
3 is SCHEMA
4 is SII
5 is TEMPLATE

-r is the resource name (optional).For example, wfd, map, schema, sii, or template.
-o is the file name to output all the messages (optional).
-g is the file name that lists all the ignored resources (optional).
-h is the help screen.

3. The DB Checksum tool performs the relevant checksum operation based on the command options and 
generates the output message.
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Installing a Perimeter Server in a Clustered Windows 
Environment
Installing a Gentran Integration Suite perimeter server in a clustered Windows environment includes the 
following tasks:

Setting Up Perimeter Servers with Gentran Integration Suite on page 47
Installing a Perimeter Server in a More Secure Network (Windows Clustered) on page 48
Installing a Perimeter Server in a Less Secure Network (Windows Clustered) on page 49
Installing Patches in a Perimeter Server Clustered Windows Environment on page 50
Starting and Stopping Perimeter Servers in Windows on page 51
Reducing Perimeter Server Security Vulnerabilities on page 51

Setting Up Perimeter Servers with Gentran Integration Suite 
Using a perimeter server with Gentran Integration Suite is optional. 

A perimeter server is a software tool for communications management that is installed in a DMZ. The 
perimeter server manages the communications flow between outer layers of your network and TCP-based 
transport adapters. A perimeter server can solve problems with network congestion, security, and 
scalability, especially in high-volume, Internet-gateway environments. A perimeter server requires a 
corresponding perimeter client. 

Gentran Integration Suite installation program installs a perimeter client and a local mode server. The local 
mode server is useful for testing purposes or in environments that do not require a secure solution. However, 
if you require high-volume, secure connections, you must install a perimeter server in a remote zone, either 
a more secure or less secure network than your integration server.

When you install a perimeter server, use these guidelines:

Licensing for a perimeter server is determined by the licensing restrictions on the corresponding B2B 
adapters in Gentran Integration Suite.
Each perimeter server is limited to two TCP/IP addresses: internal interface and external interface. 
Internal interface is the TCP/IP address that the perimeter server uses to communicate with Gentran 
Integration Suite. External interface is the TCP/IP address that the perimeter server uses to 
communicate with trading partners. 
To use additional TCP/IP addresses, install additional perimeter servers.
You may have multiple perimeter servers installed on the same computer interacting with one instance 
of Gentran Integration Suite. To install a perimeter server on a computer with an existing instance, 
install the new perimeter server in a different installation directory.
The combination of internal TCP/IP address and port must be unique for all perimeter servers installed 
on one computer.

If a perimeter server is installed using the wildcard address, then all ports must be unique.

If a perimeter server is installed using the wildcard address, then its port is not available for use by 
adapters that use the server or any other perimeter server on that computer. 
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The internal and external interface may use the same TCP/IP address. However, the port used by 
the perimeter server is not available to the adapters that use the server.

Installing a Perimeter Server in a More Secure Network (Windows 
Clustered)

To install a perimeter server in a clustered Windows environment: 

1. Close all open Windows programs.
2. Insert Gentran Integration Suite installation CD into the appropriate drive.
3. Open a DOS command window.
4. Copy the ps_2000.jar installation files from the installation CD to your home directory or base 

directory. If you are using FTP to copy the file, be sure your session is set to binary mode.
5. To begin the installation, enter the absolute path to the following jar file:

absolutePath\bin\java -jar install_dir\packages\ps_2000.jar 

The program verifies the operating system and required patch level and the location and version of the 
JDK.

6. Enter the name for the installation directory.
7. If there is an existing installation in the directory you specify, you can update it using the same 

settings.
At the prompt There is an existing install at that location, update it while keeping existing settings?, if 
you type yes and press Enter, the installation will proceed without additional entries.
Note: If you want to change any of the settings, you must use a new directory, or delete the old 
installation before performing the new installation. You cannot overwrite an existing installation, and 
you cannot use an existing directory that does not contain a valid installation. The existing installation 
must be Gentran Integration Suite 4.3 or later.
The program verifies the amount of available disk space.

8. At the prompt Is this server in a less secure network than the integration server?, type No and press 
Enter.
For more information about making the perimeter more secure, refer to Reducing Perimeter Server 
Security Vulnerabilities on page 51.

9. At the prompt Will this server need to operate on specific network interfaces?, if you type yes and 
press Enter, the program returns a list of the available network interfaces available on your host. 
Select the interfaces for the server to use.

10. Enter the TCP/IP address or DNS name that the integration server (Gentran Integration Suite) will 
listen on for the connection from this server.

11. Verify the TCP/IP address or DNS name.
12. Enter the port that the intergration server (Gentran Integration Suite) will listen on for the connection 

from this server. The port number must be higher than 1024.
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13. Enter the local port that the perimeter server will use for the connection to the integration server 
(Gentran Integration Suite). The port number must be higher than 1024, except specify a port of zero if 
you want the operating system to select any unused port.

14. Verify the port.
When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

15. Change to the installation directory.
16. Run the installPS.cmd command to install this perimeter server as a Windows Service. 
17. Run the startPSService.cmd command to start the perimeter server.

Installing a Perimeter Server in a Less Secure Network (Windows 
Clustered)

To install a perimeter server in a Windows clustered environment: 

1. Close all open Windows programs.
2. Insert Gentran Integration Suite installation CD into the appropriate drive.
3. Open a DOS command window.
4. Copy the ps_2000.jar installation files from the installation CD to your home directory or base 

directory. If you are using FTP to copy the file, be sure your session is set to binary mode.
5. To begin the installation, enter the absolute path to the following jar file:

absolutePath\bin\java -jar install_dir\packages\ps_2000.jar 

The program verifies the operating system and required patch level and the location and version of the 
JDK.

6. Enter the name for the installation directory.
7. If there is an existing installation in the directory you specify, you can update it using the same 

settings.
At the prompt There is an existing install at that location, update it while keeping existing settings?, if 
you type yes and press Enter, the installation will proceed without additional entries.
Note: If you want to change any of the settings, you must use a new directory, or delete the old 
installation before performing the new installation. You cannot overwrite an existing installation, and 
you cannot use an existing directory that does not contain a valid installation. The existing installation 
must be Gentran Integration Suite 4.3 or later.
The program verifies the amount of available disk space.

8. At the prompt Is this server in a less secure network than the integration server?, type Yes and press 
Enter.

9. At the prompt Will this server need to operate on specific network interfaces?, if you type yes and 
press Enter, the program returns a list of the available network interfaces available on your host. 
Select the interfaces for the server to use.
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10. Enter the TCP/IP address or DNS name for the internal interface to use to communicate with the 
integration server (Gentran Integration Suite.). Press Enter to use a wildcard for this address.

11. Verify the TCP/IP address or DNS name for the internal interface.
12. Enter the TCP/IP address or DNS name for the external interface to use to communicate with trading 

partners. Press Enter to use a wildcard for this address.
13. Verify the TCP/IP address or DNS name for the external interface.
14. Enter the port that the perimeter server will listen on for the connection from integration server 

(Gentran Integration Suite). The port number must be higher than 1024.
15. Verify the port.

When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

16. Change to the installation directory.
17. Enter installPS.cmd to install this perimeter server as a Windows Service. 
18. Enter startPSService.cmd to start the perimeter server.

Installing Patches in a Perimeter Server Clustered Windows 
Environment

Remote perimeter servers are not automatically updated by a service pack or patch. You must reinstall the 
perimeter server using the new perimeter server installation file supplied with the service pack or patch.

To Update a Remote Perimeter Server in a Clustered Windows environment:
1. Update your installation of Gentran Integration Suite 4.3 with the latest maintenance patch. Obtain the 

maintenance patch file from the Sterling Commerce Support on Demand Web site, at 
https://support.sterlingcommerce.com. These patch files have a name that identifies a build number. 
For example, si_43_build_4307.jar. For more information, refer to Installing the Current Maintenance 
Patch (Cluster) on page 38.

2. Locate the perimeter server patch file (ps_version_number.jar file) in the install_dir\packages 
directory of your installation of Gentran Integration Suite 4.3. These patch files have a name that 
identifies a version number. For example, ps_2006.jar.

3. Copy the file to the home directory or base directory on the remote server.
4. Stop the perimeter server using the stopPs.cmd command.
5. To begin the installation, type absolutePath\bin\java -jar filename.jar.

absolutePath is the directory name where the Java version is installed.
The program verifies the operating system and required patch level and the location and version of the 
JDK.

6. Type the full path to the installation directory. If you do not want to change any settings for your 
perimeter server, specify the same directory where the remote perimeter server was originally 
installed.
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7. At the prompt There is an existing install at that location, update it while keeping existing settings?, if 
you type yes and press Enter, the installation will proceed without additional entries.
Note: If you want to change any of the settings, you must use a new directory, or delete the old 
installation before performing the new installation. You cannot overwrite an existing installation, and 
you cannot use an existing directory that does not contain a valid installation. The existing installation 
must be Gentran Integration Suite 4.3 or later.
When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

8. Change to the installation directory.
9. Type startupPs.cmd to start the perimeter server.

Starting and Stopping Perimeter Servers in Windows
To start a perimeter server in Windows, use the startPSService.cmd command, or use the Services 
Control Panel.

To stop a perimeter server in Windows, use the stopPSService.cmd command, or use the Services 
Control Panel. To remove this perimeter server's definition as a Windows Service, use the 
uninstallPSService.cmd command.

Reducing Perimeter Server Security Vulnerabilities
When Gentran Integration Suite is deployed with a remote perimeter server in a more secure network zone, 
there is a security vulnerability. An intruder may compromise the host where the proxy resides, and take 
over the persistent connection to the perimeter server residing in the more secure zone. If this happens, the 
perimeter server will relay all the intruder's network requests past the firewall into this internal zone. 

To prevent an intrusion, limit the activities the remote perimeter server can perform on behalf of the proxy 
to specifically those activities that the proxy needs to do for its operation. 

Control these limitations by a configuration residing in the secure network zone with the remote perimeter 
server, inaccessible by the proxy that could become compromised. 

Granting Permissions for Specific Activities By a Perimeter Server
1. Install a remote perimeter server, choosing the option for a more secure network zone. Refer to the full 

perimeter server installation instructions, as described in Installing a Perimeter Server in a More 
Secure Network (Windows Clustered) on page 48.

2. At the installation prompt Is this server in a less secure network than the integration server?, select 
No, which is the option for a more secure network zone. 

3. In the perimeter server installation directory there will be a text file named restricted.policy that must 
be customized. Its initial contents are: 

// Standard extensions get all permissions by default grant codeBase 
"file:${{java.ext.dirs}}/*" {permission java.security. AllPermission;};
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 grant {
    // Grant all permissions needed for basic operation.
 
    permission java.util.PropertyPermission "*", "read";
 
    permission java.security.SecurityPermission "putProviderProperty.*";
 
    permission java.io.FilePermission "-", "read,write";
    permission java.io.FilePermission ".", "read";
 
    // Needed to allow lookup of network interfaces.
    permission java.net.SocketPermission "*", "resolve";
 };
 
 grant {
    // Adjust for your local network requirements.
 
    // Needed to connect out for the persistent connection.  Do not remove this.
    permission java.net.SocketPermission "localhost:12002", "connect";
 
    // For each target FTP Server that a FTP Client Adapter will connect to in passive 
mode.
    //
    // permission java.net.SocketPermission "ftphost:21", "connect"; // Control 
connection.
    // permission java.net.SocketPermission "ftphost:lowPort-highPort", "connect"; // 
Passive data connections.
 
    // For each target FTP Server that a FTP Client Adapter will connect to in active 
mode.
    //
    // permission java.net.SocketPermission "ftphost:21", "connect"; // Control 
connection.
    // permission java.net.SocketPermission "localhost:lowPort-highPort", "listen"; 
// Active data port range.
    // permission java.net.SocketPermission "ftphost", "accept"; // Active data 
connections.
 
    // For each target HTTP Server that an HTTP Client Adapter will connect to.
    //
    // permission java.net.SocketPermission "htttphost:443", "connect";
 
    // For each target C:D snode that the C:D Server Adapter will connect to.
    //
    // permission java.net.SocketPermission "snode:1364", "connect"
};

4. Edit this file to add permission lines for each back-end server that you intend to allow the proxy to 
access. There are commented out examples for each type of server. 

The first two grant sections are required for correct perimeter server operation. Do not modify these 
sections. 

Example

The following example grants permission to a target FTP Server:
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Note: In the example, servers are configured to listen on the following ports: 33001 (for FTP), 33002 (for 
HTTP), and 1364 (for C:D). These port numbers can be edited.

// To restrict or permit the required Host/Server to communicate with the  PS, update 
the “ftphost/ htttphost/snode” with 
      that of the Server IP and provide the appropriate PORT number where the Server 
will listen. //

   // For each target FTP Server
   // permission java.net.SocketPermission "10.117.15.87:33001", "connect"; // 
Control connection.
   // permission java.net.SocketPermission "10.117.15.87:lowPort-highPort", 
"connect"; // Passive data connections.
   // 10.117.15.87 indicates IP of the FTP Server for which the permission is granted 
by PS for communicating with client //

   // For each target HTTP Server
   //
   // permission java.net.SocketPermission "10.117.15.87:33002", "connect";
   // 10.117.15.87 indicates IP of the HTTP Server for which the permission is granted 
by PS for communicating with client //

   // For each target C:D snode
   //
   // permission java.net.SocketPermission "snode:1364", "connect";
   //  10.117.15.87 indicates IP of the Connect Direct Node for which the permission 
is granted by PS for communication //

5. Turn on restrictions. In the install directory is the perimeter server settings file:
remote_perimeter.properties. 
Edit it to change the "restricted" setting to a value of true. 

6. In the future, any attempt by the perimeter server to access disallowed network resources will be 
rejected and logged in the perimeter server log written to the perimeter server installation directory. 

Performing DNS Lookup on Remote Perimeter Server
By default, a perimeter server performs DNS lookup in the main server JVM. If you have limited DNS in 
your secure area, you can configure the remote perimeter server to look up trading partner addresses in the 
DMZ. 

To enable DNS lookup to occur at the remote perimeter server, edit the perimeter.properties file to change 
the following parameter:

Note: Do not edit the properties files. Make all the changes in the customer_overrides.properties file.

Property Name Description

<psname>.forceRemote
DNS

Enables remote DNS resolution for the perimeter server, where <psname> is the name of 
the perimeter server. Valid values:

true - enable remote DNS resolution

false - disable remote DNS resolution
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Postinstallation in a Clustered Windows Environment
After installing Gentran Integration Suite, you should complete the following tasks:

Starting Gentran Integration Suite in Windows on page 54
To stop Gentran Integration Suite, refer to Stopping Gentran Integration Suite on page 57.
Accessing Gentran Integration Suite on page 54
Validating the Installation on page 56
Downloading Gentran Integration Suite Tools on page 56
Performing Initial Administrative Setups in Gentran Integration Suite on page 56
Configuring Customer Overrides File When You Have a Firewall Between Nodes (Build 4324 or 
higher) on page 57

Starting Gentran Integration Suite in Windows
To start Gentran Integration Suite in a clustered Windows environment, double-click the Gentran 
Integration Suite icon on your Windows desktop. Gentran Integration Suite starts running. 

Note: It may take several minutes for Gentran Integration Suite components to initialize and start up.

If Gentran Integration Suite does not start or if you receive a message about an invalid or corrupt license 
file, go to the Troubleshooting: Windows Environment section.

When startup is finished, a message like the following is displayed:

Open your Web browser to http://host:port/(interface), where host:port is the host and port number where 
Gentran Integration Suite resides on your system, and (interface) is the interface used by Gentran 
Integration Suite (for example, admin or dashboard).

Make a note of the URL address so you can access Gentran Integration Suite later.

Accessing Gentran Integration Suite
To log in to Gentran Integration Suite the first time, follow these steps:

1. Be sure that Gentran Integration Suite is started and running.
2. Open a browser window and enter the address displayed at the end of startup.
3. The login page for Gentran Integration Suite displays. 
4. Type the default user ID (admin) and password (password). The default login is at an administrative 

level. One of your first tasks as an administrator is to change the administrative password and to 
register other users with other levels of permission.

Technical Note: Changes to Network Interface Bindings
To increase the security of the Administrator Console user interface, Gentran Integration Suite version 4.3 
binds only to specific network interfaces. By default, previous versions had been bound to all network 
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interfaces. After installing, if the URL for Gentran Integration Suite returns Page cannot be displayed, you 
can adjust property settings to correct the problem.

1. On the server where Gentran Integration Suite resides, edit the noapp.properties.in file.
a. Locate the admin_host parameter. The default settings are as follows:

hostname1 is the name of primary network interface, the one given highest priority by Gentran 
Integration Suite.
localhost is the name of the network interface on the server where Gentran Integration Suite 
resides.
Default entries
admin_host.1    = hostname1

admin_host.2    = localhost

b. Correct the parameters.
If no interface is being displayed, edit hostname1 so that it correctly identifies the primary network 
interface that accesses Gentran Integration Suite.
If an additional network interface needs to access Gentran Integration Suite, add an additional 
admin_host entry, as shown below. 
Edited entries
admin_host.1    = hostname1

admin_host.2    = localhost

admin_host.3    = hostname2
2. Stop Gentran Integration Suite.
3. Run the setupfiles.cmd utility located in the install_dir\bin directory.
4. Restart Gentran Integration Suite.

For the Dashboard user interface, Gentran Integration Suite version 4.3 provides unrestricted binding to 
network interfaces through the perimeter server. To restrict access to the Dashboard user interface, you can 
adjust property settings so that only one network interface accesses Gentran Integration Suite. 

1. On the server where Gentran Integration Suite resides, edit the perimeter.properties.in file.
a. Locate the localmode.interface parameter. The default setting is unrestricted, as shown below. 

Unrestricted Setting (Default)
localmode.interface=*

b. To restrict access to the Dashboard, enter the network interface that you want Gentran Integration 
Suite to support.
Restricted Setting
localmode.interface=hostname1

2. Stop Gentran Integration Suite.
3. Run the setupfiles.cmd utility located in the install_dir\bin directory.
4. Restart Gentran Integration Suite.
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Validating the Installation
After you install, start, and log in to Gentran Integration Suite the first time, you can validate the installation 
by testing a sample business process. Follow these steps:

1. Open a browser window and enter the address for Gentran Integration Suite. This address was 
displayed at the end of startup.

2. Enter your user login and password. 
3. From the Administration menu, select Business Processes > Manager.
4. In the Process Name field, type Validation_Sample_BPML and click Go!
5. Click execution manager.
6. Click execute.
7. Click Go! You see the Status: Success message in the upper left side of the page.

Downloading Gentran Integration Suite Tools
Gentran Integration Suite includes tools that run on a desktop or personal computer. After you install, start, 
and access Gentran Integration Suite, you can install the following tools by downloading them from within 
Gentran Integration Suite: 

Note: MESA Developer Studio and Reporting Services are optional features that are purchased separately 
from Gentran Integration Suite. These features each require a separate license in addition to your 
license for Gentran Integration Suite. 

Map Editor and associated standards
Graphical Process Modeler
Web Template Designer
(If licensed) MESA Developer Studio plug-ins, including:

MESA Developer Studio Software Development Kit (SDK)

MESA Developer Studio Skin Editor

(If licensed) Reporting Services, which requires MESA Developer Studio if you want to use the 
plug-ins to create fact models and custom reports.

Conflicting IP addresses can cause problems when you download a desktop tool. See the Troubleshooting: 
Windows Environment section.

Performing Initial Administrative Setups in Gentran Integration Suite
At this point, your installation is complete, and you can run Gentran Integration Suite. If you are installing 
Gentran Integration Suite for the first time, you need to perform some initial administrative setups before 
users can use Gentran Integration Suite. For example, the system administrator for Gentran Integration Suite 
must register users and grant permissions.

For security purposes, change default user ID passwords immediately after installation is completed. See 
the Editing My Account Information task in the documentation library.
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Also, it is recommended that you run several performance reports so that benchmarks are established for 
tuning the system in the future. For more information about preparing your Gentran Integration Suite system 
for effective performance tuning, refer to the performance tuning methodology information in the 
Performance and Tuning Guide.

Configuring Customer Overrides File When You Have a Firewall 
Between Nodes (Build 4324 or higher)

If you have configured a firewall between nodes that blocks ports outside of the port range assigned to 
Gentran Integration Suite, perform the following task on all nodes: 

1. Navigate to the install_dir/install/properties directory and locate (or create, if necessary) the 
customer_overrides.properties file. 

2. Open the customer_overrides.properties file using a text editor.
3. Add the following properties:

noapp.jnp_host= <host_name>

noapp.jnprmiport=<port_number_1>

noapp.jnprmiport2=<port_number_2>

noapp.jndirmiport=<port_number_3>

noapp.useSocketFactories=true

ops.jnp_host= <host_name>

ops.jnprmiport=<port_number_1>

ops.jnprmiport2=<port_number_2>

ops.jndirmiport=<port_number_3>

ops.useSocketFactories=true

This increases the number of threads used by the system. 
4. Save and close the customer_overrides.properties file.
5. Stop Gentran Integration Suite and restart it to apply the changes.

Stopping Gentran Integration Suite
To stop Gentran Integration Suite in a clustered Windows environment, follow these steps:

1. Open Gentran Integration Suite.
2. From the Administration menu, select Operations > System > Troubleshooter.
3. Click Stop the System and wait for shutdown to complete.
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Managing Nodes in a Cluster
You can add or remove nodes in a cluster environment. The following prerequisites should be considered 
before performing any modification in the cluster environment:

New nodes should have the same range of ports available as the current nodes.
Gentran Integration Suite license file should be updated to include the IP address of the new nodes.
Directory structure on the new nodes should match with the directory structure of the existing nodes.
Perimeter servers should be updated with the new IP addresses to ensure proper configuration.
Any adapters, services, or business processes assigned to or scheduled to run on the node being 
removed should be assigned to run on other nodes.

The following sections provide the necessary steps to add a node and remove a node from the cluster:

Adding a Node on page 58
Removing a Node on page 58

Adding a Node
To add a node into the cluster:

Note: You do not need to stop the cluster environment while adding a new node.
1. Install a new Gentran Integration Suite node to be added into the cluster with the –cluster option 

during installation. To install a new node, refer Installing in a Clustered Windows Environment on page 
30. Ensure that the new node being added is not a primary node.

2. Update jgroups_cluster.properties file and jgroups_cluster.properties.in file with 
the new node details.

3. Configure the new node by running the command startcluster.cmd nodeNumber from the 
install_dir\bin directory. The node number should be greater than 1.

Note: You should run startCluster.cmd command only after you install Gentran Integration Suite. You 
should not run startCluster.cmd command when you restart a Gentran Integration Suite 
instance. However, if you have installed a patch or a hot-fix, refer Custom Configurations on page 
35 to start the cluster without updating the database settings.

4. Start the new Gentran Integration Suite node. To start a node, refer Starting Gentran Integration Suite 
in Windows on page 54.

Removing a Node
To remove a node from the cluster:

1. Reassign or stop any adapters, services, or business processes assigned to or scheduled to run on the 
node being removed.
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Note: It is recommended that you restart the Gentran Integration Suite cluster environment after removing 
the node from the cluster. To restart Gentran Integration Suite cluster environment, refer Starting or 
Stopping the Cluster Environment on page 37.

2. Perform backup of the node being removed.
3. Edit jgroups_cluster.properties file and jgroups_cluster.properties.in file in all 

nodes to remove the IP address of the node being removed.
4. Uninstall Gentran Integration Suite in the node being removed. To stop a node and uninstall Gentran 

Integration Suite from a node, refer Uninstalling Gentran Integration Suite from a Clustered Windows 
Environment on page 59.

Uninstalling Gentran Integration Suite from a Clustered 
Windows Environment
When you uninstall Gentran Integration Suite, Gentran Integration Suite application is automatically 
removed from the server.

Additionally, you may perform the following tasks:

Manually remove the JDK that was installed
Free any database space in Oracle or SQL Server databases

To uninstall Gentran Integration Suite from a Windows environment, follow these steps:

1. Stop Gentran Integration Suite and wait for shutdown to complete.
2. Run install_dir\bin\uninstallWindowsService.cmd to remove the following Windows 

services:

Gentran Integration Suite 

Opsserver

Noapp server

WebDav server

You should receive a message stating that the services were successfully removed. To verify their 
removal, open the Services window:
a. Select Start > Settings > Control Panel > Administrative Tools (Windows 2000) or Start > 

Administrative Tools (Windows 2003).
b. Click Services. 
If the services were not removed, you must delete them from the Windows registry:
a. Go to the Windows registry.
b. Locate HK_LOCAL_MACHINE\System\Current Control Set\Services. 
c. Delete the keys for Gentran Integration Suite and Opsserver. These registry keys start with 

Gentran Integration Suite. 
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d. Reboot to apply the registry changes.
3. If the JDK is not being used by another application, remove it. 

a. Select Start > Settings > Control Panel (Windows 2000) or Start > Control Panel (Windows 
2003).

b. Select Add/Remove Programs (Windows 2000) or Add or Remove Programs (Windows 2003).
c. Select Java 2 SDK Runtime Environment Standard Edition v<version number> and click 

Remove.
d. Select Java 2 SDK Standard Edition v<version number> and click Remove.
e. Close all windows and return to your desktop.

4. Remove the product installation folder from the Windows path:
a. In your Windows desktop, right-click My Computer.
b. Select Properties.
c. Click the Advanced tab.
d. Click Environment Variables.
e. In the System variables window, select Path.

f. Click Edit.
The system displays the Edit System Variable dialog box.

g. Delete the following entries located in Variable Value.
<install_dir>\SI\lib\jnipass\1_0\windows;
<install_dir>\mysql2\SI\packages\lib\jni;
<install_dir>\mysql2\SI\packages\lib\jni\windows2000

h. Click OK.
i. Close all windows to return to your desktop.

5. Delete the folder where Gentran Integration Suite was installed, including all subfolders. For example, 
delete C:\SterlingCommerce and its subfolders.

6. If you use an Oracle or SQL Server database, these remain intact even after you remove Gentran 
Integration Suite from the server. If you no longer want to reference the data, contact your database 
administrator about removing the unwanted tables and recovering the database space where Gentran 
Integration Suite resided.

7. After you remove Gentran Integration Suite from the server, you can remove Eclipse and any tools that 
were downloaded to the desktop:
Note: You can remove Eclipse plug-ins without removing Eclipse. Refer to the Eclipse on-line help for 
information about removing the plug-ins.
Note: MESA Developer Studio and Reporting Services are optional features that are purchased 
separately from Gentran Integration Suite. These features each require a separate license in addition to 
your license for Gentran Integration Suite. 
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Map Editor and associated standards

Refer to the Map Editor Guide for information about removing the Map Editor.

Graphical Process Modeler

Refer to the Graphical Process Modeler Guide for information about removing the Graphical 
Process Modeler.

Web Template Designer

Refer to the Web Extensions Guide for information about removing the Web Template Designer.

(If licensed) MESA Developer Studio plug-ins, including the Software Development Kit (SDK) 
and Skin Editor.
To remove these items, follow this procedure:
a.Using Windows Explorer, locate the installation directory of Eclipse (For example, C:\Program 

Files\eclipse). 
b.Navigate to the features directory and delete the folders for anything from Sterling Commerce, 

gisstudio, skineditor, and servicesdk. 
c.Navigate to the plugins directory and delete the folders for anything from Sterling Commerce, 

gisstudio, skineditor, and servicesdk.

(If licensed) Reporting Services, which requires MESA Developer Studio if you want to use the 
plug-ins to create fact models and custom reports.

Troubleshooting: Windows Environment (Cluster)

Situation Message or Symptom Explanation/Resolution

Installing You encounter errors or problems 
during installation.

Explanation
Installation creates two log files, one for the first (bootstrap) 
phase and a second for the actual installation phase.
Resolution
Examine the log files generated during installation:

install_dir\bootstrap.log

install_dir\SI\installSI.log

Installing During installation, you select the 
destination directory and the 
installation program stops running.

Explanation
The command window was closed after you selected the 
destination directory.
Resolution
Delete the destination directory and re-start the installation 
process. Do not close the command window.
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Installing You started the installation program 
but realize that the license file has not 
been downloaded.

Resolution
Minimize the installation window, obtain the license file, and 
then continue with the installation procedure.

Installing During installation, you identify the 
initial port number and then see the 
message: Port number is already in 
use.

Resolution
Choose one:

Use a different port number.

Stop the service that is using the port number that you 
want to use.

Installing During installation, you enter database 
information and see the message: 
Information is incorrect.

Explanation
One or more of the criteria for the database is incorrect. 
Resolution
Click Back to redisplay the dialog box that asks for the 
database information. Correct the error and click Next.

Installing Installation appears to complete 
successfully, but Gentran Integration 
Suite services are not installed.

Explanation
You may have reinstalled Gentran Integration Suite on a 
Windows server and chosen the same initial port. 
Resolution
If this is the case, either reinstall Gentran Integration Suite in a 
different directory using a different port, or follow the steps 
below to uninstall the existing Gentran Integration Suite 
services prior to reinstalling Gentran Integration Suite.
1 Run install_dir\bin\stopWindowsService.cmd and wait 

for all Gentran Integration Suite Windows services to 
stop. 

2 Run install_dir\bin\uninstallWindowsService.cmd and 
log off. This cleanly removes the old Windows services 
from Windows cache and verifies that there are no 
scheduled jobs running in the background.

3 Delete the install_dir directory. 
4 You can now install the new version of Gentran 

Integration Suite at the same port. 

Installing After installing Gentran Integration 
Suite, a gisInstall.* subdirectory is left 
in the current working directory. This 
can cause the file system to become 
full.

Explanation
The Java installer is not allowed to delete the 
gisInstall.*/platform_core_2000.jar because it is “in use” by the 
JVM. 
Resolution
Manually delete the leftover gisInstall.* subdirectory on 
Windows after each installation attempt.

Starting If Gentran Integration Suite does not 
start, examine the log file in 
<install_dir> \SI\logs for an invalid or 
corrupt license file. 

Resolution
Obtain the license file. Then restart Gentran Integration Suite.

Situation Message or Symptom Explanation/Resolution
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Installing a 
desktop 
tool or 
resource

Cannot download any of the following:
Note: MESA Developer Studio 

and Reporting Services are 
optional features that are 
purchased separately from 
Gentran Integration Suite. 
These features each 
require a separate license 
in addition to your license 
for Gentran Integration 
Suite. 

Map Editor and associated 
standards

Graphical Process Modeler

Web Template Designer

(If licensed) MESA Developer 
Studio plug-ins (Software 
Development Kit (SDK), Skin 
Editor)

(If licensed) Reporting Services, 
which requires MESA Developer 
Studio if you want to use the 
plug-ins to create fact models and 
custom reports.

Explanation
When you install Gentran Integration Suite, system files are 
created that contain an internal IP address. If you install 
Gentran Integration Suite behind a firewall, and your firewall is 
configured to accept an external IP address from a client 
computer, you may not be able to download the desktop tools 
and resources. The firewall will reject the IP address from a 
client residing outside of the firewall. 
Resolution
Modify the system files that contain the invalid IP address. 
Follow these steps:
1 Navigate to the install_dir\bin directory.
2 Enter the following command followed by the external 

IP address:
patchJNLP.cmd external_IP_address

3 Stop Gentran Integration Suite. 
4 Restart Gentran Integration Suite. 

Accessing Attempts to access the URL for 
Gentran Integration Suite display the 
message: Page cannot be displayed.

See Technical Note: Changes to Network Interface Bindings 
on page 54.

Situation Message or Symptom Explanation/Resolution
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Chapter 4

Installing and Configuring MESA Developer
Studio

Overview for Installing and Configuring MESA Developer 
Studio
Gentran Integration Suite MESA Developer Studio is an Integrated Development Environment (IDE) that 
uses Eclipse software plug-ins. Use the MESA Developer Studio to connect with a Gentran Integration Suite 
instance for resource access and control of operations of Gentran Integration Suite, change the template that 
Gentran Integration Suite uses, and develop custom services—all from within a development environment.

In addition to MESA Developer Studio, the following plug-ins are available:

MESA Developer Studio SDK – for developing and deploying custom services and adapters.
MESA Developer Studio Skin Editor – for customizing the look and feel of Gentran Integration Suite 
interface.
Reporting Services – a separately-licensed set of plug-ins used to create fact models and reports for 
Gentran Integration Suite.

Note: MESA Developer Studio and Reporting Services are optional features that are purchased separately 
from Gentran Integration Suite. These features each require a separate license in addition to your 
license for Gentran Integration Suite. 

Assumptions and Prerequisites
Read the following assumptions and prerequisites prior to installing MESA Developer Studio:

Basic knowledge of Gentran Integration Suite and its architecture. This is especially important if you 
are using MESA Developer Studio SDK to create services and adapters. 
Basic knowledge of Eclipse is assumed. For more information, see the Eclipse online help or go to the 
Eclipse web site.
Extensive knowledge of how to create and deploy a service. 
Thorough knowledge of and experience with the Java programming language for creating services.
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You have the required MESA Developer Studio (and if purchased, Gentran Integration Suite) product 
licensing.

Steps to Set Up MESA Developer Studio
Setting up MESA Developer Studio is a multi-step process which should be completed in the order 
described. The following is a checklist for each stage in the process. The checklist provides an overview of 
the entire process. Separate instructions for completing each step are available:

1. Install and configure Gentran Integration Suite.
2. Download and install the latest Gentran Integration Suite patch.
3. Download and install a full release version of Eclipse. For more information, see the download page of 

the Eclipse web site.
Note: MESA Developer Studio requires specific plug-in versions. We recommend you to install 
Eclipse for MESA development only. If you are using Eclipse with development projects other than 
MESA, disable plug-ins that report conflicts.

4. Download and install the latest version of Java 2 SDK Standard Edition 5.0 (or higher) on the same PC 
that you installed Eclipse. It is important that you have the full SDK and not just the JRE. 

After installation, additional configuration is required. 
5. Verify that MESA Developer Studio uses the correct JRE. 
6. Install the MESA Developer Studio (and if purchased, Gentran Integration Suite) Plug-ins.
7. Set up Gentran Integration Suite Instance in MESA Developer Studio. 
8. Set up Gentran Integration Suite resources to be used with MESA Developer Studio. 

Eclipse Terms
The following Eclipse terms might be used in this documentation when describing MESA Developer Studio 
components:

Project - All the resources related to a particular implementation reside in a project. It can contain 
folders, files, and other Eclipse objects. 
Workspace - Directory where work is stored.
Workbench - UI window that contains these elements:

Perspective - group of views and editors in a Workbench window that correspond to a certain 
project. 

View - visual component within the Workbench and dependent on the perspective that was 
selected. Used to navigate or display information such as properties or messages.

Editors - visual component in the Workbench used to create, change, or browse a resource.
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Configuring J2SE on Your PC
In order for Eclipse to work correctly, you must have Java 2 SDK Standard Edition 5.0 (or higher) installed 
on the same PC you installed Eclipse. You need to have the full SDK installed. The JRE alone is not enough. 
You must close Eclipse to download and install the JDK. After installing J2SE, you must configure your PC 
to use it.

To configure your PC for the new JDK:

1. Select Start > Settings > Control Panel > System (Windows 2000) or Start > Control Panel > 
System (Windows 2003).

2. Click the Advanced tab.
3. Click Environment Variables.
4. Under System Variables, click New.
5. Complete the following and click OK:

Variable Name - type JAVA_HOME.

Variable Value - type the directory path for the location where you installed the J2SE SDK. The 
default location is C:\j2sdk5.0\.

6. Click OK to exit.

Verifying that MESA Developer Studio Uses the Correct JRE
In addition to adding a home directory on Windows for this JDK instance, you must also verify that MESA 
Developer Studio uses the correct JRE.

To verify the MESA Developer Studio JRE:

1. Open Eclipse.
2. From the Window menu, select Preferences.
3. Expand the Java section and select Installed JREs. The Installed JREs window appears.
4. If C:\j2sdk5.0 is not listed (location and version may be different, but version should be as listed or 

higher), click Add and go to next step.
If it is listed, make sure it is selected and click OK. You are ready to use MESA Developer Studio.

5. Complete the following and click OK:

JRE Name - type any name for this JRE.

JRE home directory - click Browse to select the home directory you defined in the Configuring 
J2SE on Your PC section.

Default VM Arguments - leave blank.

JRE system libraries - make sure Use default system libraries is selected.
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6. Click OK to exit.

Starting the WebDAV Server
MESA Developer Studio uses a WebDAV server to provide access to Gentran Integration Suite resources, 
including MESA Developer Studio plug-in updates. This WebDAV server is automatically installed with 
Gentran Integration Suite for use with MESA Developer Studio. 

The WebDAV server starts automatically with Gentran Integration Suite in Windows. 

Gentran Integration Suite (Windows)
The WebDAV server that is used with MESA Developer Studio is implemented as a service, and starts 
automatically when you start Gentran Integration Suite (startWindowsService.cmd). When Gentran 
Integration Suite is stopped (stopWindowsService.cmd), the WebDAV server, and MySQL if used, 
remains running. This is necessary to start and stop instances of Gentran Integration Suite from within 
Eclipse and MESA Developer Studio.

You can stop the WebDAV Server Service using stopWebdavWindowsService.cmd. Also, when 
Gentran Integration Suite and WebDAV Server Service are running and WebDAV Server Service gets 
stopped Gentran Integration Suite (and MySQL if used) will remain running. The logfilename of the 
WebDAV Server Service is dav.log.

Installing MESA Developer Studio Components
You must install and configure MESA Developer Studio to connect with the desired Gentran Integration 
Suite instances for resource access and for control operations of Gentran Integration Suite from within 
MESA Developer Studio. Use this procedure to install Gentran Integration Suite plug-ins, as well.

Changing Proxy Preferences
You might need to change you proxy server settings to enable an HTTP proxy connection between the PC 
where you have Eclipse installed and the server where Gentran Integration Suite is installed. 

To change proxy settings:

1. From the Windows menu, select Preferences > Install/Update. 
2. Under Proxy settings, type your proxy information.
3. Click OK.
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Installing New Features
To install MESA Developer Studio:

1. Open Eclipse. 
2. Select a default workspace folder location. You can add additional workspace folder locations at any 

time. The Package View in the lower left area of the MESA Developer Studio workspace displays a 
local explorer view of your project folders. This enables you to store files that you check out.

3. From the Eclipse Help menu, select Software Updates > Find and install.
4. Select Search for new features to install.
5. Click Next.
6. Click New Remote Site.
7. Complete the following information and click OK.

Name – type a descriptive name for the application server. 

URL – type the IP address or name of your server. Format is 
http://<servername>:<WebDAVportnumber>/eclipse.

Your new site will appear in the list of sites to include in the search.

8. Select the checkbox to the left of the new site. Click Finish. 
The system verifies the selected site and displays the results. On the search results page, expand the 
update site node and select from the following plug-ins, according to your licenses:

MESA Developer Studio 

Service SDK

Skin Editor

Gentran Integration Suite (automatically selects all three Gentran Integration Suite plug-ins: Fact 
Model Editor, Report Editor, and Report Format Editor)

Cautions: 

Do not change the default installation path for the plug-ins.

If you are selecting Gentran Integration Suite, you must also select the MESA Developer Studio 
plug-in (unless you have already installed MESA Developer Studio). Dependencies require that 
the MESA Developer Studio plug-in be installed either before or at the same time as Gentran 
Integration Suite plug-ins.

9. Click Next. Accept the terms of the license and click Next.
10. Click Finish.
11. Click Install All to accept the feature verification.

You must restart Eclipse for the changes to take affect.
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Setting Up a Gentran Integration Suite Instance
You can only view resources that are available for the specified Gentran Integration Suite instance. If a 
desired resource resides in a different Gentran Integration Suite installation you must configure a new 
instance in MESA Developer Studio to work with it.

Note: If you are installing Gentran Integration Suite, you must complete this task. 
1. From the Window menu, select Open Perspective > Other.
2. Select MESA Developer Studio and click OK. 
3. In the MESA Developer Studio view in the upper left, right-click and select New instance. 
4. Complete the following information and click Finish: 

Hostname - name of machine for Gentran Integration Suite install.

Port - WebDAV port assigned at install.

Name - name you assign to this Gentran Integration Suite connection.

User name - valid Gentran Integration Suite user name (for example, admin).

Password - valid Gentran Integration Suite password.

MESA Developer Studio attempts to establish a connection to the instance using the WebDAV server. 
The status of the instance is displayed:

Red – the instance has not been started.

Yellow – the instance was started but is not yet running.

Green – the instance is running.

Note: Refresh the workspace to see a newly added environment.

Editing Connection Information
Once you have set up Gentran Integration Suite instance for use with MESA Developer Studio, you can edit 
the connection information, view configuration details, test the connection, and refresh the connection.

To edit the connection information:

1. Right-click on the instance name.
2. Select Edit. 
3. Edit the settings as needed.
4. Click Finish.

MESA Developer Studio attempts to establish a connection to the instance using the new information. 
The status is displayed (green, yellow, or red) according to the status of the instance.
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Viewing Configuration Details
To view configuration details, double-click on the instance name. 

Note: The ports on the Overview window are static. Only the ports present at install are displayed. Any 
changes or additions made after installation are not displayed.

Refreshing the Instance
Use Refresh if you have locked or unlocked business processes and maps through in Gentran Integration 
Suite, and you want to see their current status in MESA Developer Studio.

To refresh Gentran Integration Suite instance connection:

1. Right-click on the instance name.
2. Select Refresh

The Progress Information window appears and closes automatically when the refresh process is 
complete. The status is displayed (green, yellow, or red) according to the status of the instance.

Installing Additional MESA Developer Studio Components and 
Updates
You can install additional MESA Developer Studio components not installed at the time of the original 
installation at any time. To install additional components follow the steps listed in the section Installing 
MESA Developer Studio Components. The system verifies that the license file has newly licensed 
components and installs them.

The system verifies that the additional components are licensed in Gentran Integration Suite. If not, you are 
asked to provide new connection parameters to Gentran Integration Suite instance that has the appropriate 
license for the additional MESA Developer Studio components. Once the license check is complete, the new 
components are activated.

If you are updating an existing component, restart Eclipse in order for the new component to be updated.

Installing Reporting Services Plug-Ins
Reporting Services works with Gentran Integration Suite MESA Developer Studio, which is an Integrated 
Development Environment (IDE) that uses Eclipse software plug-ins. The Reporting Services Fact Model 
Editor, Report Editor, and Report Format Editor are all accessed as Eclipse plug-ins.

Note: MESA Developer Studio and Reporting Services are optional features that are purchased separately 
from Gentran Integration Suite. These features each require a separate license in addition to your 
license for Gentran Integration Suite. 
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Installing Additional MESA Developer Studio Components and Updates
To set up the Reporting Services plug-ins:

1. Follow the procedures for the MESA Developer Studio configuration. 
Note: When completing the procedure Installing MESA Developer Studio Components, ensure that 
you select both the Reporting Services plug-ins and the MESA Developer Studio plug-in for download 
and installation in Eclipse. 
Caution: The MESA Developer Studio plug-in is a prerequisite for the Reporting Services plug-ins. 
You must install it either with or prior to installing the Reporting Services plug-ins. 
After installing the MESA Developer Studio and Reporting Services plug-ins, complete the following 
tasks:

2. Start the WebDAV server for your Gentran Integration Suite instance. 
3. Start the Event Listeners.
4. Configure your Eclipse installation to point to Gentran Integration Suite WebDAV server. 
5. Customize the Window Perspective in Eclipse to include Sterling Commerce Reporting Services. This 

makes the Reporting Services options available directly from the Eclipse menus. In Eclipse, select 
Window > Customize Perspective. In the Shortcuts pane on the left, select Sterling Commerce 
Reporting Services and click OK. 
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Properties to Prevent Cross-Site Script Vulnerabilities
Chapter 5

Configuring Properties

After installing Gentran Integration Suite, you must set up a few property and script files in order for 
Gentran Integration Suite to run properly. This chapter describes the properties you must set up before 
configuring Gentran Integration Suite to run according to your business needs. 

Properties to Prevent Cross-Site Script Vulnerabilities
In some cases, data to and from Gentran Integration Suite can contain HTML characters that impact the 
display and the original intent of the input. In addition, data can be input that contains malicious HTML, 
such as commands embedded within <SCRIPT>, <OBJECT>, <APPLET>, and <EMBED> tags.

In Gentran Integration Suite, potentially malicious data being output to the browser can be rendered 
harmless by implementing the provided encoding mechanism. This prevents these malicious scripts from 
being run by the browser. 

Any presence of these characters triggers Gentran Integration Suite to safely encode the data. 

For more detailed information about malicious scripts, see the following articles: 

CERT Advisory, Malicious HTML Tags Embedded in Client Web Requests. Available from the CERT 
web site.
CERT Advisory, Frequently Asked Questions About Malicious Web Scripts Redirected by Web Sites. 
Available from the CERT web site.

Setting the Database Connection Properties
Database properties are configured during installation.  They are put in  
install_dir/properties/jdbc.properties files.

Note: After making modifications to the required files, rebuild the resource jar.
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To enable database connection pooling, create the pool, configure the data source entry for JNDI, and 
specify it as the datasource name. For connection pooling used by other application servers refer to the 
vendor’s manual on connection pooling.

Properties for LDAP User Authentication
This section assumes you understand how LDAP servers work. Sterling Commerce also recommends that 
you read the following documents on LDAP technology:

W. Yeong, T. Howes, and S. Kille, RFC 1777 - Lightweight Directory Access Protocol. March 1995. 
Available at http://rfc.net/rfc1777.html.
Mark Wilcox, Implementing LDAP. Wrox Press, 1999. 

By default, all authentication is performed against the Gentran Integration Suite database. When a user 
enters a login ID and password, it is validated against the login ID and password that is stored in the 
database. This requires the administrator of Gentran Integration Suite to set up login IDs and passwords for 
each user.

Alternatively, the Application Console supports LDAP-based user authentication. You may choose to use 
an LDAP server for authentication. When using LDAP, the users, user groups, and access control must be 
set up in Gentran Integration Suite. 

Gentran Integration Suite also supports password expiration through LDAP. Your custom code for user 
authentication is interfaced with the Gentran Integration Suite authentication mechanism. If your custom 
code contains ExpireInDays with a numeric value of <X>, then a message to reset the password appears 
on the Gentran Integration Suite home page. If the map contains ChangePasswordLink, then the message 
contains a link to the location specified. Clicking on the link opens a new window with the given 
ChangePasswordLink.

Since the various implementations of LDAP handle password expiration differently, a sample 
YFSLDAPAuthenticator is provided as an example of one particular implementation. This is located in the 
install_dir/xapidocs/code_examples directory.

To set properties for LDAP-based authentication, do the following:

1. Install the LDAP server (see the installation instructions from your LDAP server vendor).
2. If a JAAS-compliant provider is used, create a JAAS configuration file with the following lines:

LDAP

{

  // refer to the JAAS compliant service provider for the login 

     module details.

  <Class Name of the Login Module as specified by the Security 

  provider> required

debug=true;

};

3. Specify the LDAP properties described in the following table:
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Properties for LDAP User Authentication
Property Description

WebLogic startWLS startup file

-Djava.security.auth.login.config If you are using JAAS and WebLogic, specify the full path to your 
JAAS configuration file. 

In the Configurator UI

Configure organizations, organization units, 
and users. 

All users who need to access Gentran Integration Suite must be 
set up under the LDAP server. All Gentran Integration Suite 
users must belong to the same organizational unit.
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Installation Utilities
Chapter 6

Configuring Utilities

Gentran Integration Suite supplies sample script files (.sh for UNIX and .cmd for Windows) that you must 
customize using the directions provided in this chapter. 

This chapter describes all the utilities supplied by Gentran Integration Suite, organized by the order in which 
you are likely to use them. It describes generic customizations that apply to most or all utilities. Further 
details specific to each utility are provided throughout the rest of this guide. 

Installation Utilities
Note: On UNIX, all utilities within the install_dir/bin directory must have permissions set to 755.

Installation utilities enable you to install Gentran Integration Suite. These utilities are present in the 
install_dir/bin directory. Some of the utilities used for installing the various configurations of Gentran 
Integration Suite are the following:

loadDefaults
This utility loads the standard installation database configuration, known as the "factory defaults". 
dbverify
This utility verifies the changes between your database setup and the entity XML files. 

Loading Gentran Integration Suite Database Factory Defaults
 To load Gentran Integration Suite database factory defaults:

1. Load the defaults, using the script applicable to your operating system. From the command line, run 
loadDefaults.sh on UNIX and Linux or loadDefaults.cmd on Windows and pass the absolute 
file path to the installer:
loadDefaults.sh 
install_dir/installed_data/platform/factorysetup/installer.xml
Sterling Commerce, an IBM Company 75



Installation Utilities
Note: If the factory default installation stops before it is finished, a file name "installer.xml.restart" is 
created. This file records the location where the installation was stopped, and it is used the next time 
the factory defaults are installed.

Verifying the Database
Gentran Integration Suite provides a database verification and correction tool to ensure database schema 
integrity. To set up the Database Verification Tool:

1. From the command line, run the dbverify.sh or dbverify.cmd script and pass the userID and 
password parameters as follows:
dbverify.sh/cmd userId password

Note: When using Oracle, modify the yfs.tables.sql file to reference your newly created tablespaces.

2. If you want to ignore the third-party tables when verifying the database, modify the dbverify.sh (or 
.cmd on Windows) script, which is located in the install_dir/bin folder. 
Add the -DIgnore3rdPartyTables=Y parameter as specified in the below example. The third-party 
tables are not defined in Gentran Integration Suite entity XML or extension XML file. For example,
%JAVA_HOME%\bin\java -DIgnore3rdPartyTables=Y 
com.yantra.tools.dbverify.DbVerifyCommandLine -b %INSTALL% -u %USERNAME% -p 
%PASSWD% -d %DRIVER% -url %URL% -g Y -DT 
%INSTALL%/template/api/YFSDataTypes.xml

Note: If you have custom or third-party tables in your database and you receive an exception while 
running the dbverify.sh (or .cmd on Windows) script, use this parameter to ignore the custom or 
third-party tables.

3. The differences between the entity XMLs and the database are generated in the form of SQL scripts, 
which can be run against the database to rectify the differences. The following scripts are generated:

EFrame_Sequence.sql - This script creates all of the additional sequences that need to be 
created.

Note: If you are using a Microsoft SQL Server 2000/2005 database, EFrame_Sequence.sql is not 
created when you run the dbverify command.

Note: When reducing the size of a column, a comment will be logged in the 
EFrame_TableDrops.sql rather than a sql statement in the EFrame_TableAlters.sql.

EFrame_TableChanges.sql - This script contains all the table column differences that need to 
be applied on the database schema. Modify this file to reference your tablespaces.

EFrame_TableDrops.sql - This script removes any extra tables in the database.

EFrame_IndexAdds.sql - This script adds all of the indexes that need to be created in the 
database. Modify this file to reference your tablespaces.

EFrame_IndexDrops.sql - This script removes any extra indexes in the database.
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EFrame_TextIndexUpdates.sql - This script contains all the text search indexes related 
differences that need to be applied on the database schema.

4. Run install_dir/database/scripts/dbtype/ImportExport_View.sql and Interop_Views.sql scripts 
manually, where dbtype is either mySQL, DB2, Oracle, SQL server 2000 or SQL server 2005, 
depending on what you are using for a DBMS.
For example, if there is a mismatch in the size of a datatype for a column [varchar2(20) to 
varchar2(40)] that has an associated index, the DBVerify tool generates SQL statements for:

Dropping the index

Changing the size of the datatype for the column

Creating the new index

All three SQL statements listed above appear in different *.sql files. The appropriate *.sql files 
must be run in a proper order as follows:
a. Run EFrame_IndexDrops.sql for dropping the index.
b. Run EFrame_TableChanges.sql for altering the size of the datatype for a column.
c. Run the EFrame_IndexAdds.sql for creating a new index.
If the SQL statements are not run in the sequence as mentioned above, it results in script failure.
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Appendix A

Configuring for a Non-English Environment

You can install Gentran Integration Suite in an English or a non-English environment. By modifying a few 
system settings, you can then configure Gentran Integration Suite for your locale.

This section includes the following topics:

Installing the Language Pack on Windows on page 78
Installing on a Remote Computer on page 78
Loading Gentran Integration Suite Language Pack Factory Defaults on page 79
Configuring Encodings for Gentran Integration Suite on page 79
Configuring Locales on page 81

This chapter also explains how to install, load the factory defaults, and check the import mode of Gentran 
Integration Suite language packs. 

Installing the Language Pack on Windows
To install Gentran Integration Suite language pack on Windows, insert the language CDs that you received 
from Sterling Commerce into your CD-ROM drive, open the Win directory, and run the setup.exe 
command.

Note: Before installing the language pack be sure that you have successfully installed Gentran Integration 
Suite.

Installing on a Remote Computer
To install Gentran Integration Suite language pack on a Remote Computer, you can install Gentran 
Integration Suite Language Packs onto any supported remote UNIX server. You cannot install Gentran 
Integration Suite Language Packs onto a remote Windows server.
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Loading Gentran Integration Suite Language Pack Factory Defaults
If you received any language CDs from Sterling Commerce, FTP the setup.bin file from the appropriate 
operating system directory of the CD-ROM to the remote UNIX server. 

Loading Gentran Integration Suite Language Pack Factory 
Defaults
To load the language-specific factory defaults run the loadDefaults.sh script for UNIX and Linux or 
the loadDefaults.cmd script for Windows available in the install_dir/bin directory and pass the 
locale-specific installer file. For example:

loadDefaults.cmd install_dir/database/FactorySetup/install/ 
<language>_<country>_locale_installer.xml

The default locale that is shipped with the CD is ja_JP. 

Loading Gentran Integration Suite Language Pack Translations
Prior to loading Gentran Integration Suite Language Pack factory defaults, be sure that you have 
successfully completed all instructions in the database tier software chapter.

To load the language pack translation with custom localization literals, run the LocalizedStringReconciler 
tool in the IMPORT mode from the install_dir/bin directory as follows:

ant -f localizedstringreconciler.xml  import 
-Dsrc= /database/FactorySetup/XMLS

This tool first inserts the value specified in the 
<from_language>_<from_country>_ycplocalizedstrings_<to_language>_<to_country>.properties file 
present in the install_dir/database/FactorySetup/XMLS/<language>_<country> directory into the database.

Note: Verify that your locale settings such as currency, time format, date, and so forth, are correct.

Switching Gentran Integration Suite Base Language
The base language for the Application Configurator can be switched only once. 

Configuring Encodings for Gentran Integration Suite
Language settings for Java applications involve both character sets and encoding:

A character set is a set of characters (letters, numbers, and symbols such as #, $, and &) that are 
recognized by computer hardware and software.
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Configuring Encodings for Gentran Integration Suite
An encoding is a representation of data in a particular character set. An encoding set is a group of 
encodings. 
For information about basic and extended encoding sets, see the java web site.

The default encoding for Gentran Integration Suite is 8-bit Unicode Transformation Format (UTF-8). 

Gentran Integration Suite provides two property files that contain supported encoding sets. These properties 
files reside in the install_dir/properties directory.

encodings.properties – Contains the default encoding set used in Gentran Integration Suite interface.
encodings_large.properties – Contains all supported encoding sets.

The default encoding set in Gentran Integration Suite includes the following encodings:

UTF-8
IS0-8859-1
ISO-8859-5
US-ASCII
ISO_8859-1
EUC-JP
UTF-16
ISO-2022-JP

You are not limited to the encodings in the encoding.properties file. Gentran Integration Suite enables you 
to configure the encodings properties files to expand the number of encodings you can use.

To configure your encoding set:

1. Stop Gentran Integration Suite and wait for shutdown to complete.
2. Change to the install_dir/properties directory.
3. Open the encodings_large.properties file. Select the encodings you want to add to the 

encodings.properties file.
4. Open the encodings.properties.in file.
5. At the end of the encodings.properties.in file, add the encodings you selected from the 

encodings_large.properties file. When adding encodings from one file to the other, first copy the 
encodings as they appear in the encodings_large.properties file. After adding the new encodings, 
ensure that the index numbers are consecutive. If the index numbers are not consecutive, change the 
index number or numbers as needed. For example, encoding54 cannot follow encoding6. In this 
example, change encoding54 to encoding7.
The first name in the definition (before the comma) is the name that will appear in the Gentran 
Integration Suite user interface. You can change this name to make it more descriptive. For example:

encoding4 = 819,ISO8859_1

may be changed to

encoding4 = WesternEurope,ISO8859_1
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ISO8859_1 is the Java canonical name and should not be changed.
6. Update the first line in the encodings.properties.in file (numberof). Change numberof to the number of 

encodings added to the file. For example, if the current value is numberof = 6 and you add 5 new 
encodings, the new value is numberof = 11.
numberof indicates the total number of encodings located in the file. You must update numberof to 
ensure that the encodings you added will be visible in the user interface.

7. Change to the install_dir/bin directory.
8. Run the setupfiles.sh script or the setupfiles.cmd script (Windows only).
9. Start Gentran Integration Suite. 

Configuring Locales
Gentran Integration Suite runs in any locale that Java supports. If you want to run Gentran Integration Suite 
in a non-default locale, then configure your environment to the specific locale you want to use. 

To configure your operating system as a non-English environment, consult your operating system’s 
documentation.To determine and set the locale in a UNIX or Linux environment:

1. Enter locale -a. A list of locales is displayed.
2. Set your locale by entering:

export LANG <locale> 

export LC_ALL <locale> 

Example to set the locale to Japanese (on Solaris): 
• export LANG ja_JP
• export LC_ALL ja_JP

Note: Some UNIX shells require the setenv command instead of the export command.

To determine and set your locale in a Windows environment:

1. Select Control Panel > Regional Options > General tab.
2. From the Your locale (location) list, select the language and location. 
Note: Click Set Default and select the locale from the Set the appropriate locale list.
Sterling Commerce, an IBM Company 81



Index
A
administrator login 54

C
capacity planning 8

ccaseid.jar 45

cross-site script vulnerabilities
malicious HTML 72
prevention 72

customizations 38

D
data migrator

properties file 73

data migrator properties 73

database sizing 8
capacity planning 8
future disk estimation 9

database user privileges 10
DB2 17
Oracle 10
Oracle, application user 11
SQL server 15

database verification 76

databases
configuring 8
DB2 18, 19
MySQL 19
Oracle 12
reinstalling 8
sizing 8

DB2
client components, compilers, and fixpack 18
codepage selection 17
configuring 17
database sizing 11, 17

installation 17
installing 17
JDBC drivers 19
parameters 18
permissions 19
production environment 17
schema change script 44
using 18

decryption, Windows password 20

disk estimation 9

E
EFrame_IndexAdds.sql 76

EFrame_IndexDrops.sql 76

EFrame_Sequence.sql 76

EFrame_TableChanges.sql 11, 76

EFrame_TableDrops.sql 76

EFrame_TextIndexUpdates.sql 77

encryption
Windows password 20

F
factory defaults 75, 76

fix_db2_schema.sql 44

G
Graphical Process Modeler

downloading 56, 63
removing 61

H
hot-fix 44

hot-fix installation 44

hot-fixes 38
Sterling Commerce, an IBM Company 82



Index
HTML characters
impacting display 72

I
installer restart file 76

installing 30
DB2 17
hot-fix 44
JDK 25
Oracle 9
perimeter server 47, 48
silent installation 28
SQL Server 15
troubleshooting 61, 62
troubleshooting Windows 62
validating 56

installing database software
DB2 17
Oracle 9
SQL Server 15

installWindowsService.cmd 45

interface
network bindings 54

J
Java 2 Software Development Kit. See JDK

JDK
installation 25
patch installation 50

L
language pack

installing (Windows) 78
installing on remote computer 78
loading factory defaults 79
loading language pack translations 79
switching base language 79

language settings
default encoding 80

languages, supported 81

LDAP user authentication 73
assumption 73
for application consoles 73
Sterling Commerce, an IBM Company 83



Index
modifying configurator UI 74
modifying weblogic startup file 74
password expiration 73
password expiration, change password link 73
password expiration, expire in days 73
properties 73

license files 27

loading factory defaults,database factory defaults 75

locales 81

localization 81

login
default 54

M
Map Editor

downloading 56, 63
removing 61

MESA Developer Studio
downloading 56
installing 64
removing 61

Microsoft SQL Server. See SQL Server

MySQL databases 19

N
named pipes 15

network interfaces 54

noapp.properties 34, 35, 36, 55

non-English environment 78

non-English language 81

O
Oracle 12

configuring 11
copying JDBC driver 10
creating views 11
database user privileges 10
installing 9
production environment 11
running create instance 9

Oracle administrative user 10
Sterling Commerce, an IBM Company 84



Index
P
Page cannot be displayed error 54

password
decrypting password (Windows) 20
default 54
encrypting database passwords 20
encrypting password (Windows) 20
expiration 73

patches 38

perimeter server
installing 48
setup 47
starting 51
stopping 51

port numbers 26

postinstallation 54

property files 72
noapp.properties 34, 35, 36, 55
sandbox.cfg 32, 36, 40, 41

R
reinstalling

databases 8

removing
system 59

Reporting Services
configuring 70
downloading 56, 63
installing 70
removing 61
WebDAV server 71

running
Oracle scripts 12
SQL Server scripts 15

S
sandbox.cfg 32, 36, 40, 41

script
installWindowsService.cmd 45
uninstallWindowsService.cmd 45

security
decrypting password (Windows) 20
Sterling Commerce, an IBM Company 85



Index
encrypting password (Windows) 20

setting database connection properties 72

setting up
database verification tool 76
Oracle scripts 11

silent installations 28

SQL Server
configuring 15
enabling named pipes 15
enabling TCP/IP 15
production environment 15
sizing, See Also database sizing 15

starting
perimeter server 51
system 54
troubleshooting 62

startupPs.cmd 51

stopping
perimeter server 51
system 57

system
removing 59
starting 54
stopping 57
uninstalling 59

system administration, initial 56

system requirements 25

T
TCP/IP 15

troubleshooting 61, 62
access 54
installation 56
Page cannot be displayed 54
starting 62

U
uninstallWindowsService.cmd 45

user ID
default 54

UTF-8 character set 80

utilities
Sterling Commerce, an IBM Company 86



Index
installation 75

utilities, installation
dbVerify 75
loadDefaults 75

V
validating installation 56

verifying database 76

W
Web Template Designer

downloading 56, 63
removing 61

WebDAV server 67
using with Reporting Services 71
Sterling Commerce, an IBM Company 87


	Introduction
	Setting Up the Database (Windows)
	Creating and Configuring the Database Server (Windows)
	Database Sizing
	Capacity Planning
	Tracking and Estimating Future Disk Requirements

	Installing Oracle
	Choosing a Character Set
	Oracle Database User Privileges
	Configuring an Oracle Database for Production

	Using an Oracle Database Server
	Setting Database Parameters in Oracle
	Rolling Back or Undoing Changes in Oracle
	Granting Permissions in Oracle
	Installing the JDBC Driver in Oracle (Windows)
	Enabling Failover in a Multiple Node Oracle RAC Database Cluster (Windows)

	Installing Microsoft SQL Server 2000/2005
	Setting Database Parameters in SQL Server
	SQL Server Database User Privileges
	Configuring a SQL Server Database for a Production Environment
	Installing the JDBC Driver in SQL Server
	Installing the JDBC Driver in SQL Server 2000
	Installing the JDBC Driver in SQL Server 2005
	Configuring Snapshot for Microsoft SQL Server 2005

	Installing DB2
	DB2 Database User Privileges
	Configuring a DB2 Database for Production

	Using a DB2 Database Server
	Installing Client Components, Compilers, and Fixpack
	Setting Parameters for DB2
	Granting Permissions for DB2
	Installing JDBC Drivers for DB2

	Using a MySQL Database Server (Non-Clustered Only)

	Managing Database Passwords
	Database Password Encryption Methods
	Encrypting Database Passwords (Windows)
	Decrypting Database Passwords (Windows)

	Installing in a Clustered Windows Environment
	Preinstallation Setup Checklist for a Clustered Windows Environment
	Checklist for Windows Preinstallation
	Checking System Requirements
	Installing the Java 2 Software Development Kit
	Downloading the JCE Distribution File
	Determining Port Numbers
	Obtaining a License File
	Silent Installations
	Installing the JDBC Driver in SQL Server
	Installing the JDBC Driver in SQL Server 2000
	Installing the JDBC Driver in SQL Server 2005


	Installing in a Clustered Windows Environment
	Cluster Setup (Windows)
	Multiple Nodes
	Custom Configurations
	Node to Node Communications
	Configuring Shared File System as Document Storage
	Cluster Environment Verification
	Starting or Stopping the Cluster Environment

	Patches and Hot-Fixes (Cluster)
	Installing the Current Maintenance Patch (Cluster)
	Applying a Patch in a Clustered Environment Stopping the Whole Cluster
	Applying a Patch in a Clustered Environment Stopping One Node at a Time
	Updating the Database (dbupdate) with the startCluster Command
	Running a DB2 Schema Change Script

	Installing a Hot-Fix (Cluster)
	Before Installing a Hot-Fix
	Hot-Fix Installation
	Hot-Fix Package Delivery Method

	Performing Checksum using DB Checksum Tool

	Installing a Perimeter Server in a Clustered Windows Environment
	Setting Up Perimeter Servers with Gentran Integration Suite
	Installing a Perimeter Server in a More Secure Network (Windows Clustered)
	Installing a Perimeter Server in a Less Secure Network (Windows Clustered)
	Installing Patches in a Perimeter Server Clustered Windows Environment
	To Update a Remote Perimeter Server in a Clustered Windows environment:

	Starting and Stopping Perimeter Servers in Windows
	Reducing Perimeter Server Security Vulnerabilities
	Granting Permissions for Specific Activities By a Perimeter Server
	Performing DNS Lookup on Remote Perimeter Server


	Postinstallation in a Clustered Windows Environment
	Starting Gentran Integration Suite in Windows
	Accessing Gentran Integration Suite
	Technical Note: Changes to Network Interface Bindings

	Validating the Installation
	Downloading Gentran Integration Suite Tools
	Performing Initial Administrative Setups in Gentran Integration Suite
	Configuring Customer Overrides File When You Have a Firewall Between Nodes (Build 4324 or higher)
	Stopping Gentran Integration Suite

	Managing Nodes in a Cluster
	Adding a Node
	Removing a Node

	Uninstalling Gentran Integration Suite from a Clustered Windows Environment
	Troubleshooting: Windows Environment (Cluster)
	Installing and Configuring MESA Developer Studio
	Overview for Installing and Configuring MESA Developer Studio
	Assumptions and Prerequisites
	Steps to Set Up MESA Developer Studio
	Eclipse Terms

	Configuring J2SE on Your PC
	Verifying that MESA Developer Studio Uses the Correct JRE
	Starting the WebDAV Server
	Gentran Integration Suite (Windows)

	Installing MESA Developer Studio Components
	Changing Proxy Preferences
	Installing New Features

	Setting Up a Gentran Integration Suite Instance
	Editing Connection Information
	Viewing Configuration Details
	Refreshing the Instance

	Installing Additional MESA Developer Studio Components and Updates
	Installing Reporting Services Plug-Ins

	Configuring Properties
	Properties to Prevent Cross-Site Script Vulnerabilities
	Setting the Database Connection Properties
	Properties for LDAP User Authentication
	Configuring Utilities
	Installation Utilities
	Loading Gentran Integration Suite Database Factory Defaults
	Verifying the Database

	Configuring for a Non-English Environment
	Installing the Language Pack on Windows
	Installing on a Remote Computer
	Loading Gentran Integration Suite Language Pack Factory Defaults
	Loading Gentran Integration Suite Language Pack Translations
	Switching Gentran Integration Suite Base Language

	Configuring Encodings for Gentran Integration Suite
	Configuring Locales
	Index

